ILLUSTRATOR CS5
for Windows and Macintosh
Visual QuickStart Guide

Elaine Weinmann
Peter Lourekas

Peachpit Press
Acknowledgments

We’re grateful to many people for their individual contributions to this book.

Nancy Aldrich-Ruenzel, publisher of Peachpit Press, has enthusiastically supported our projects for over a decade.

Susan Rimerman, our editor, keeps the many wheels in motion for us at Peachpit.

Victor Gavenda, longtime editor at Peachpit, tech edited this book in Windows with cleverness and wit.

Production editor Lisa Brazieal gave us speedy answers to our production questions and did an expert job of spearheading the prepress production before sending our files off to RR Donnelley for printing.

Many other Peachpit Press staff members do important work, such as Nancy Davis, editor-in-chief; Gary-Paul Prince, PTG tradeshow and conventions manager; Keasley Jones, business manager; and Glenn Bisignani, marketing manager.

Illustrator pro artists Harry Campbell, Celia Johnson, Chris Lyons, and Daniel Pelavin kindly permitted us to reproduce some of their work (see pages 425–431). We know it will be a source of inspiration to our readers. (For their contact information, see page 432.)

Elaine Soares, photo research manager, and Lee Scher, photo research coordinator, of the Image Resource Center at Pearson Education, the parent company of Peachpit Press, quickly procured the stock graphics from Shutterstock.com that we requested.

As book packagers, we know that no book is complete without some final polishing. Rebecca Pepper, copy editor, scoured our pages for errors with great care and made intelligent corrections.

Steve Rath generated the index and Scout Festa did the final round of proofreading.

This book would have no reason for being without the software that is its subject matter. We commend Adobe Systems, Inc. for making significant improvements to what was already a great product. We thank the Adobe Illustrator CS5 team, and in particular David Macy, senior product manager for Adobe Illustrator, Harpreet Singh, project lead of the Adobe prerelease program, and Silas Lepcha, now a quality engineer.

And finally, we’re blessed with loyal friends and family, who are understanding when we’re in deadline mode, give our lives some semblance of balance, and are present for us to love and enjoy even more when we reemerge.

Elaine Weinmann and Peter Lourekas
Chapters at a glance

1  Create & Save Files . . . . . . 1
2  Manage Color ............... 15
3  Workspaces ................. 23
4  Panels .................... 37
5  Bridge ..................... 55
6  Geometric Objects ....... 75
7  Freehand Drawing ......... 83
8  Select ..................... 89
9  Move, Copy & Align ....... 99
10 Fill & Stroke ............... 111
11 Transform .................. 137
12 Reshape ................... 147
13 Layers ...................... 171
14 Appearances ............... 189
15 Effects ..................... 197
16 Graphic Styles ............. 209
17 Live Trace .................. 219
18 Live Paint .................. 227
19 Create Type ................. 239
20 Style & Edit Type ......... 253
21 Pen Tools ................. 279
22 Acquire Images ............ 287
23 Brushes .................... 297
24 Gradients .................. 317
25 Combine Paths ............. 327
26 Clipping Masks ............ 341
27 Transparency ............... 349
28 Symbols .................... 355
29 Live Color .................. 369
30 Preferences ............... 377
31 Print ...................... 391
32 Export ..................... 411
Contents

1 Create & Save Files
Launching Illustrator .................................. 1
Creating a new document ★ .......................... 3
Using templates ....................................... 4
Adding artboards to a document ★ .................... 7
Deleting artboards ★ ................................. 9
Modifying artboards ................................ 10
Aligning and rearranging artboards ★ ................ 11
Choosing artboard options ★ .......................... 12
Saving a document in the Adobe Illustrator (ai) format ★ ........................................ 13
Ending a work session .................................. 14

2 Manage Color
Introduction to color management ...................... 15
Choosing color settings for Illustrator ................. 17
Synchronizing the color settings ........................ 20
Changing the document profile ......................... 21
Proofing a document onscreen ★ ........................ 22

3 Workspaces
Features of the Illustrator workspace .................. 23
Using tabbed document windows ....................... 25
Arranging document windows .......................... 26
Changing the zoom level ................................ 27
Fitting an artboard in the document window ★ ...... 28
Moving an area of a document into view ............... 28
Changing the screen mode ................................ 29
Switching document views ★ .......................... 30
Creating custom views .................................. 31
Configuring the panel groups and docks. ............... 32
Choosing and saving workspaces ......................... 34

4 Panels
The Illustrator panel icons .............................. 38
The Tools panel ★ ..................................... 39
The Control panel ...................................... 42
The other essential panels illustrated ★ ................. 43

5 Bridge
Opening files from Illustrator ......................... 55
Launching Adobe Bridge .............................. 56
Features of the Bridge window ★ ....................... 56
Choosing a workspace for Bridge ....................... 58
Previewing graphics in Bridge .......................... 60
Opening files from Bridge ★ ............................ 62
Customizing the Bridge workspace ..................... 64
Saving custom workspaces ............................. 66
Resetting the Bridge workspace ....................... 66
Using thumbnail stacks ................................ 67
Searching for files ..................................... 68
Creating and using collections ★ ....................... 69
Rating and labeling thumbnails ......................... 71
Choose a sorting order .................................. 72
Filtering the display of thumbnails ..................... 72
Assigning keywords to files ............................ 73
Exporting the Bridge cache ............................. 74
Managing files using Bridge ............................. 74

6 Geometric Objects
Selecting and deleting objects ★ ......................... 75
Creating rectangles and ellipses ....................... 76
Creating polygons ..................................... 78
Creating stars ......................................... 79
Creating line segments ................................ 81
Creating spirals ....................................... 82
Creating pixel-perfect artwork for the Web ★ ....... 82

7 Freehand drawing
A quick color primer .................................... 83
Drawing with the Pencil tool ★ ......................... 84
Drawing with the Paintbrush tool ★ .................. 85
Choosing options for the Pencil and Paintbrush tools .......................... 86
Drawing with the Blob Brush tool ...................... 87
Choosing options for the Blob Brush tool ............ 88

8 Select
The five selection tools ................................. 89
Using the Selection tool ★ ............................. 91
Using the Direct Selection tool ......................... 92
Selecting objects via a command ★ ................... 92
Selecting objects via the Layers panel ................ 93
Working with groups .................................. 94
Isolating individual objects ............................ 96
Using the Lasso tool ................................. 96
Using the Magic Wand tool .......................... 97
Saving selections ...................................... 98
Selecting and deselecting all objects ................... 98

9 Move, Copy & Align
Moving objects ........................................ 99
Aligning objects with the help of Smart Guides ...... 100
Contents

10 Fill & Stroke
Using color in Illustrator ............................................. 111
Colors for your output medium .................................... 112
Using the basic color controls ..................................... 114
Saving colors as swatches .......................................... 116
Choosing colors via the Color panel .............................. 117
Applying colors from a library ..................................... 118
Changing the tint percentage ....................................... 119
Changing the stroke weight, alignment, caps, and joins .......................... 120
Creating arrows ★ ...................................................... 121
Creating a dashed stroke ★ .......................................... 122
Using the Eyedropper tool ......................................... 123
Using the Swatches panel .......................................... 124
Using the Color Guide panel ...................................... 128
Using the Kuler panel .............................................. 131
Replacing colors in your artwork ................................ 132
Inverting colors ....................................................... 133
Colorizing grayscale images ...................................... 133
Blending fill colors ................................................... 134
Creating and editing fill patterns .................................. 135

11 Transform
Transforming an object via its bounding box ..................... 137
Using the Free Transform tool .................................... 138
Using the Scale, Rotate, Shear, and Reflect tools ............. 140
Using the Transform and Control panels ★ .................... 142
Using the Transform Each command ★ .......................... 144
Using the Transform effect ........................................ 145
Repeating a transformation ....................................... 146

12 Reshape
The building blocks of a path .................................... 147
Moving points and segments .................................... 148
Reshaping curves ...................................................... 148
Converting points .................................................... 149
Adding points ........................................................ 151
Deleting points ........................................................ 154
Reshaping objects with the Pencil or Paintbrush tool ........ 155
Applying a variable width profile preset to an object's stroke ★ ........................................ 156
Changing an object's stroke width using the Width tool ★ ........................................ 157
Reshaping objects with the Blob Brush tool .................. 160
Exercise: Draw and reshape objects in a freehand style .... 161
Using the Reshape tool ............................................. 162
Exercise: Draw a brush with the Reshape tool ............... 162
Erasing sections of objects ........................................ 163
Aligning points ....................................................... 164
Joining endpoints ★ .................................................. 165
Reshaping objects using commands ............................ 166
Slicing and dicing ..................................................... 168
Exercise: Draw a glass of beer (or cream soda!) ............ 170

13 Layers
Getting to know the Layers panel ................................ 171
Creating layers ★ ...................................................... 173
Deleting layers and objects ....................................... 175
Selecting layers on the Layers panel ★ .......................... 176
Selecting objects via the Layers panel ......................... 178
Restacking layers and objects .................................... 181
Duplicating layers and objects ................................... 182
Locking layers and objects ........................................ 183
Hiding layers and objects ......................................... 184
Collecting objects into a new layer ............................... 185
Releasing objects to a layer ....................................... 186
Merging layers and groups ....................................... 187
Flattening layers .................................................... 188

14Appearances
Applying appearance attributes ★ ................................ 190
Editing appearance attributes ★ ................................ 194
Hiding and deleting appearance attributes ..................... 195
Copying appearance attributes ................................ 196
Expanding appearance attributes ................................ 196

15 Effects
Applying Illustrator effects ........................................ 197
Editing, duplicating, and deleting effects ...................... 200
A few Illustrator effects up close ............................... 201
Rasterizing objects .................................................. 206
Applying Photoshop effects via the Effect Gallery ........ 207
16 Graphic Styles
Graphic styles basics .................................. 209
Loading graphic styles from a library ........... 211
Applying graphic styles ......................... 212
Removing graphic styles ....................... 213
Adding graphic styles ......................... 214
Creating graphic styles ....................... 215
Redefining graphic styles .................... 216
Deleting graphic styles from the panel ....... 217
Creating a custom graphic style library ....... 218
Breaking the link to a graphic style .......... 218

17 Live Trace
The tracing features in Illustrator .............. 219
Tracing a raster image ......................... 220
Applying tracing options ................... 221
Managing tracing presets .................. 224
Releasing a tracing ......................... 224
Converting a tracing to paths ............... 225

18 Live Paint
Creating a Live Paint group .................. 228
Using the Live Paint Bucket tool ............ 229
Using the Live Paint Selection tool ......... 232
Reshaping a Live Paint group ............... 234
Adding new faces and edges to a Live Paint group .... 235
Choosing gap options for a Live Paint group .... 236
Expanding and releasing Live Paint groups ... 237

19 Create Type
The type tools .................................. 239
Choosing a font and font size for a type tool . 240
Creating point type ......................... 240
Creating type in a rectangle ............... 241
Creating area type ......................... 242
Creating path type ......................... 244
Copying or moving type characters .......... 246
Importing text into Illustrator .......... 247
Threading type objects ...................... 248
Rotating type ................................ 250
Exercise: Putting type on a circle ........... 251

20 Style & Edit Type
Selecting type .................................. 253
Changing the font .......................... 255
Changing the font size ...................... 256
Changing the leading value ................. 257
Applying kerning and tracking ............... 258
Using smart punctuation ...................... 260
Inserting alternate glyphs ................... 261
Applying hyphenation ....................... 263
Changing paragraph alignment ............. 264
Changing paragraph indentation .......... 265
Changing inter-paragraph spacing ........ 265
Using paragraph and character styles ....... 266
Hanging punctuation ....................... 270
Setting tabs .................................. 270
Changing the baseline shift value ......... 272
Creating type outlines ..................... 273
Creating special effects with type .......... 274
Exercise: Create a shadow for point type .... 275
Applying appearance attributes to type .... 276
Exercise: Add multiple strokes to a character ... 277
Exercise: Use the Free Distort effect on type ... 278

21 Pen Tools
Drawing with the Pen tool ..................... 279
Converting anchor points on paths .......... 283
Exercise: Draw a knife with the Pen tool .... 285

22 Acquire Images
How images are acquired in Illustrator ...... 287
Using the Open command .................... 288
Using the Place command ................... 289
Importing Photoshop images into Illustrator 290
Managing linked images .................... 292
Dragging and dropping images into Illustrator ... 296

23 Brushes
Applying brushes to existing paths .......... 298
Using the Brushes panel .................... 299
Removing brush strokes .................... 300
Expanding brush strokes .................... 301
Creating and editing Calligraphic brushes .... 302
Creating and editing Scatter brushes ....... 304
Creating and editing Art brushes .......... 306
Creating and editing Bristle brushes ....... 309
Painting brush strokes inside objects ....... 312
Duplicating brushes ....................... 313
Editing brushes manually .................. 314
Editing brush strokes on objects .......... 315
Deleting brushes .......................... 316
Creating brush libraries ................... 316
In this chapter, you will become acquainted with basic features of the Illustrator interface, such as the Application bar, document tabs, and panels. You will learn how to arrange document windows, change the document zoom level, fit an artboard in the document window, bring a different part of a document into view, change the screen display mode and document view, save and choose custom view settings, reconfigure the panel groups and docks, and save and manage your custom workspaces. By the end of the chapter, you will know how to configure your workspace to suit your usual workflow — and even better, you will have the skills to create custom workspaces for various kinds of tasks.

Features of the Illustrator workspace
In Windows — and when displayed in the Mac OS — an Application frame houses the Application bar, tabbed document windows, the Control panel, and all the other panels. Mac OS users, we recommend keeping the frame visible (see the next page). Note: We also refer to the application window in Windows as the “Application frame.” The Application frame cannot be hidden in Windows.

Although you have the option to float individual document windows onscreen or dock them as multiple tabs within a floating window, we recommend docking them as tabs within the Application frame instead, for several reasons. First, the Application frame conveniently blocks out any Desktop clutter; without the frame, you would have to spend time enlarging your document windows to hide the clutter. Second, the frame displays your document against a neutral light gray background, which is helpful when you need to judge the colors in your artwork. And third, when your document is displayed in Normal Screen mode, the viewing area expands or contracts dynamically as you hide or show the panels or collapse or expand any of the panel docks (see page 32).

Continued on the following page
To show (or hide) the Application frame in the Mac OS:

To show the Application frame, check Window > Application Frame A (or to hide it, uncheck the command).

➤ You can resize the Application frame by dragging an edge or a corner.

➤ To minimize the Application frame in Windows, click the Minimize button; or to do this in the Mac OS, double-click the Application bar.

To use the Application bar:

Use the button and menus on the Application bar to manage your workspace. B If the bar is hidden in the Mac OS, choose Window > Application Bar. In Windows, the main Illustrator menus also display on the Application bar.

To search for info at Adobe.com and other websites, enter a keyword or phrase in the Search for Help field, then press Return/Enter.

A In the Mac OS, we prefer to work with the Application frame showing.

B These controls are available on the Application bar in the Mac OS.
Using tabbed document windows

You can dock multiple open document windows into the Application frame as a series of tabs, and then display any document easily by clicking its tab.

**To dock document windows into the Application frame as tabs:**

Do any of the following:

To dock a floating document window manually, drag its title bar to the tab area (just below the Control panel) of the Application frame, and release the mouse when the blue drop zone bar appears.  

If one or more documents are already docked as tabs and you want to dock all floating document windows into the Application frame, right-click a tab and choose **Consolidate All to Here** from the context menu.  Or on the Arrange Documents menu on the Application bar, click the **Consolidate All** (first) icon; this icon is available even when all documents are floating.

To set a preference so that all documents you subsequently open will dock as tabs automatically, go to Illustrator/Edit > Preferences > User Interface and check **Open Documents as Tabs**.

- To cycle among the currently open documents, press Cmd-~ (tilde)/Ctrl-Tab.
- To fit an artboard in the document window, see page 28.
- To turn a tabbed document window into a floating one, either right-click the tab and choose Move to New Window, or drag the tab downward out of the tab area. To dock one floating document window into another one, drag its title bar to just below the title bar of the other window.
Arranging document windows

By using icons on the Arrange Documents menu on the Application bar, you can quickly display multiple documents in various layouts, such as two documents arranged side by side or vertically, or four or six documents in a grid.

To display multiple tabbed document windows:

On the Application bar, click the Arrange Documents menu icon to open the menu, then click one of the available icons (the availability of icons depends on the number of open documents).

If any open documents are floating when you click an option on the Arrange Documents menu, they will be docked as tabbed windows automatically.

To redisplay one tabbed document window:

Do either of the following:

- Right-click a document tab and choose Consolidate All to Here from the context menu.
- On the Arrange Documents menu on the Application bar, click the Consolidate All (first) icon.

A different zoom level can be chosen for each document window.
**Changing the zoom level**

By changing the zoom level for your document, you can display multiple artboards, one artboard, or a magnified detail of your artwork. The current zoom level is listed as a percentage between 3.13% and 6400% on the document tab or title bar and in the lower left corner of the document window. The zoom level has no bearing on the output size.

There are many ways to change the zoom level in a document. The fastest method is via the keyboard, because you can do it with any tool selected. Pick a few methods that you like, memorize them, and ignore the rest.

**To change the zoom level:**

Do any of the following:

- Use any of the shortcuts that are listed in the sidebar at right.
- Choose a preset percentage from the zoom menu in the lower left corner of the document window. Or choose Fit on Screen from the same menu to fit the entire artboard within the current document window size.
- Make sure no objects are selected, then right-click in the document and choose Zoom In or Zoom Out.
- Double-click the zoom field in the lower left corner of the document window, type the desired zoom level, then press Return/Enter. Or if you want to try out a zoom value without exiting the zoom field, press Shift-Return/Shift-Enter.
- Display the Navigator panel. Click the Zoom Out or Zoom In button, or move the Zoom slider, or Cmd-drag/Ctrl-drag across a section of the preview to magnify the area of the document that it corresponds to.

- To move a different part of your magnified artwork into view, see the next page.
- You can change the zoom level while the screen is redrawing.

**SHORTCUTS FOR ZOOMING IN AND OUT**

<table>
<thead>
<tr>
<th>Mac OS</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fit current artboard in the window</strong></td>
<td><strong>Fit all artboards in the window</strong></td>
</tr>
<tr>
<td>Cmd-0 (zero)</td>
<td>Ctrl-0 (zero)</td>
</tr>
<tr>
<td><strong>Fit all artboards in the window</strong></td>
<td><strong>Actual size</strong></td>
</tr>
<tr>
<td>Cmd-Option-0 (zero)</td>
<td>Cmd-1</td>
</tr>
<tr>
<td><strong>Zoom in</strong></td>
<td><strong>Zoom out</strong></td>
</tr>
<tr>
<td>Cmd- + (plus) or Cmd-Spacebar click or drag</td>
<td>Cmd- - (minus) or Cmd-Option-Spacebar click</td>
</tr>
</tbody>
</table>

**USING THE ZOOM TOOL**

We think the other methods described on this page are more convenient to use than the zoom tool (Z), but if you decide to use it, select it, then do any of the following:

- In the document window, click in the center of, or drag a marquee across, the area to be magnified. The smaller the marquee, the higher the zoom level.
- Option-click/Alt-click in the document window to reduce the zoom level.
- Drag a marquee and then, without releasing the mouse, press and hold down the Spacebar, move the marquee over the area to be magnified, and release the mouse.
Fitting an artboard in the document window

To fit an artboard to the bounds of the document window, use either one of these methods.

**To fit an artboard within the document window:** ★

Do either of the following:

- On the Artboards panel, double-click an artboard name. **A** Or if the chosen artboard is already displaying, just click the name once.
- Using the artboard navigation controls at the bottom of the document window, do either of the following: From the Artboard Navigation menu, choose an artboard number, **B** or click the First, Previous, Next, or Last arrow.

The chosen artboard will zoom to fit within the document window.

➤ To merely activate an artboard without fitting it to the document window, click in it with the Selection tool (in the document) or click an artboard number in the leftmost column of the Artboards panel.

➤ To learn more about artboards, see pages 7–12.

Moving an area of a document into view

To move a different area of a document into view:

Do either of the following:

- Choose the Hand tool (H) or hold down the Spacebar to turn the current tool into a temporary Hand tool, and drag the artwork to the desired position.
- Display the Navigator panel, then drag the Proxy Preview area (red outlined box) on the panel.

➤ If your cursor is inserted in a type object, pressing the Spacebar will add spaces to the text. If you’re using a type tool and you want to move the document in the window without switching tools, see the sidebar on page 247.

➤ You can also move a different part of a document into view by clicking any of the scroll arrows at the edge of the document window.
Changing the screen mode

The three screen modes control the display of various features of the Illustrator interface.

To change the screen mode for Illustrator:

Press (and keep pressing) F to cycle through the three screen modes, or from the Screen Mode menu at the bottom of the Tools panel, choose one of the following:

Normal Screen Mode B (the default mode) to display the Application frame (if that option is on), menu bar, Application bar, document tabs, and panels, with the Desktop visible behind everything. This is the only mode in which a tabbed document window resizes dynamically as you hide or show the panels or resize a panel.

Full Screen Mode with Menu Bar C to display the document in a maximized window with the menu bar, Application bar, scroll bars, and panels visible, but not the document tabs or document title bar.

Full Screen Mode to display the illustration in a maximized window with the scroll bars visible but all the Illustrator features (and the Dock/Taskbar) hidden.

A Choose from the Screen Mode menu at the bottom of the Tools panel.

B With our document in Normal screen mode, we pressed Tab to hide all the panels and the Control panel; the document window enlarged to fill the area left by the panels. If we were to redisplay the panels (by pressing Tab again), the document window would shrink to its former size.

C Here we have chosen the Full Screen Mode with Menu Bar option.
Switching document views

A document can be displayed and edited in four different views: Preview, Outline, Pixel Preview, and Overprint Preview. In all the views, the other View menu commands — Hide/Show Edges, Artboard, Print Tiling, Slices, Guides, and Grid — are accessible. (For Overprint Preview view, see page 403.)

To switch document views:

Do any of the following:

- Press Cmd-Y/Ctrl-Y to toggle between Preview view **A** and Outline view **B** (View > Preview and View > Outline). In Preview view, all fill and stroke colors and all placed images are visible; in Outline view, objects display as wireframes with no fill or stroke colors. Another option is to deselect (click a blank area of the document), then right-click in the document and choose Outline or Preview from the context menu. The screen redraws more quickly in Outline view.
- To activate a 72-ppi view so you can see what your vector graphics would look like if you were to rasterize them and view them in a Web browser, choose View > Pixel Preview **C** (or press Cmd-Option-Y/Ctrl-Alt-Y), and also choose View > Actual Size (Cmd-1/Ctrl-1). See also the sidebar below.

➤ Cmd-click/Ctrl-click the visibility (eye) icon for a layer (not an individual object) on the Layers panel to toggle Preview and Outline views for just that layer. See also the sidebar on page 185.

**SNAPPING ARTWORK TO THE PIXEL GRID**

➤ When you choose the Pixel Preview view command, View > Snap to Pixel is also enabled (Snap to Grid becomes Snap to Pixel). Edges of objects will snap to the nearest pixel grid line as you move or reshape them, and horizontal and vertical edges will look crisper onscreen. This reduces the need for anti-aliasing, which makes objects look smoother but also less crisp.

➤ To view a representation of the pixel grid in Pixel Preview view, check Show Pixel Grid (Above 600% Zoom) in Illustrator/Edit > Preferences > Guides & Grid, and choose a document zoom level of 600% or higher. 

---

**A** This artwork is displayed in Preview view.

**B** Here it’s displayed in Outline view.

**C** And here it’s displayed in Pixel Preview view.
Creating custom views

You can save up to 25 custom views in the current document, and you can switch among them by using either the View menu or their assigned shortcuts. Each custom view can include a zoom level, the display of a specific artboard, and a choice of Preview or Outline view.

To save a custom view:

1. Do all of the following:
   - Choose a zoom level for your document.
   - If the document contains multiple artboards, display the one you want to choose a view for (see page 28).
   - Choose Preview, Outline (Cmd-Y/Ctrl-Y), or Pixel Preview (Cmd-Option-Y/Ctrl-Alt-Y) view.


3. In the Name field, type a descriptive name for the new view, for easy identification (as in “160% view, Preview, Artboard 4”).

4. Click OK. The view is now listed on, and can be chosen from, the bottom of the View menu.

➤ Unfortunately, custom views can be created only for a specific document—not for the application. However, custom views can be saved as part of a document template (see page 5).

To rename or delete a custom view:

1. Choose View > Edit Views.

2. In the Edit Views dialog, click the view to be renamed or deleted.

3. Do either of the following:
   - Change the name in the Name field.
   - Click Delete to delete the view.

4. Click OK. The View menu will update to reflect your edits.

➤ If you want to rename more than one view, you have to click OK and then reopen the dialog for each one. It’s a simple little system.

A Type a Name for a custom view in the New View dialog.

B In the Edit Views dialog, click a view name, then change the Name or click Delete.
Configuring the panel groups and docks

In Illustrator, the panels are as indispensable as the tools. You can easily minimize, collapse, or hide them so they don’t intrude on your document space when you’re not using them, and expand or display them when you need to access them.

In the predefined workspaces (see page 34), the panels are arranged in docks on the right side of your screen — except for the Tools panel, which is docked on the left side. The panels are stored in groups within the docks (A, next page). In this section, we’ll show you how to open and close the panels, and reconfigure the panel groups and docks to suit your workflow. For a description and illustration of the individual panels, see the next chapter.

To show or hide the panels:

To show a panel: Choose the panel name from the Window menu. The panel will display either in its default group and dock or in its last open location (floating or in a dock). To bring a panel to the front of its group, click its tab (the panel name). Some panels can also be opened temporarily via a link on the Control panel or Appearance panel; see the sidebar on page 42.

Close a panel or group: To close (but not collapse) a panel, right-click the panel tab and choose Close from the context menu. To close a whole panel group, choose Close Tab Group from the context menu. To close a group that’s collapsed to icons, expand the dock first by clicking the Expand Panels button.

Hide or show all the panels: Press Tab to hide or show all the open panels, including the Tools panel, or press Shift-Tab to hide or show all the panels except the Tools panel.

Make hidden, docked panels reappear: After you have hidden the panels via the Tab or Shift-Tab shortcut, move the pointer over the dark gray vertical bar inside the right edge of the Application frame. The panel docks (but not freestanding panels) will redisplay temporarily. Move the pointer away from the panels, and they’ll disappear again. Note: If this isn’t working, redisplay the panels, then right-click any panel icon or tab and choose Auto-Show Hidden Panels from the context menu.

Every panel has a menu in the upper right corner, from which you can choose options for that panel.

To reconfigure the panels:

Expand a panel that’s collapsed to an icon: Click the icon or panel label. If Auto-Collapse Icon Panels is checked in Illustrator/Edit > Preferences > User Interface and you open a panel from an icon, it will collapse back to the icon when you click elsewhere. With this preference unchecked, the panel will remain expanded; to collapse it back to an icon, click the Collapse to Icons button on the panel bar, or click the panel icon or label in the dock.

Maximize or minimize an expanded panel or group (vertically): Double-click the panel name or the gray bar. For some panels, such as Character, Color, or Color Guide, you can cycle through its three states (display more or fewer options) by clicking the expand/collapse arrow icon on the tab.

Collapse a whole dock to icons or to icons with labels: Click the Collapse to Icons button at the top of the dock (B, next page), or double-click the dark horizontal gray bar. Repeat to expand it.

Change the width of an expanded dock; or expand icons to icons with labels, or vice versa: Position the mouse over the vertical left edge of the dock (cursor), then drag horizontally (C, next page).

Move a panel to a different slot in the same group: Drag the panel tab to the left or right.

Move a panel into a different group: Drag the panel tab over the title bar of the desired group, and release the mouse when the blue drop zone border appears (D, next page).

Change the location of a panel group in a dock: Drag the gray title bar upward or downward, and release the mouse when the horizontal blue drop zone bar is in the desired location (E, next page).

Create a new dock: Drag a panel tab or gray title bar sideways over the vertical left edge of the dock (F, next page), and release the mouse when the blue vertical drop zone bar appears.

Reconfigure a dock that’s collapsed to icons: The methods are similar to those for an expanded group. Drag the group “title” bar (double dotted line) to the edge of a dock to create a new dock;

Instructions continue on page 34
A The panels in the left dock are collapsed to icons with labels (in three groups), whereas ones in the right dock are expanded (in four groups). The Layers/Artboards group is minimized vertically.

B We clicked the Collapse to Icons button to collapse the whole right dock to icons. The panel groups were preserved.

C We dragged the edge of the left dock to the right to shrink it to just icons (no labels).

D A blue drop zone border appears as we drag the Symbols panel to the title bar of the Color/Color Guide group.

E A blue horizontal drop zone bar appears as we move a panel group upward to a new slot in the same dock.

F A blue vertical drop zone bar appears as we drag a panel out of a dock, to create a new dock for it.
or drag the title bar upward or downward between groups to restack it (look for a horizontal drop zone line); or drag the title bar into another group to add it to that group (look for a blue drop zone border). A–B

**Float a docked panel or group:** Drag the panel tab, icon, or gray title bar out of the dock. To stack floating panels or groups, drag the top bar of one so it meets the bottom of another, and release the mouse when a blue drop zone bar appears.

➤ To reset the panels to their default visibility states and locations, choose Essentials from the Workspace menu on the Application bar.

➤ To prevent a floating panel from docking as you move it around onscreen, hold down Cmd/Ctrl.

➤ If you inadvertently take the panel docks out of the Application frame, drag the dark gray bar (at the top) to the right edge of the Application frame, and release the mouse when a vertical blue drop zone line appears.

### Choosing and saving workspaces

When you choose a predefined Illustrator workspace, the panels and panel groups that are most suited to a particular sphere of work appear onscreen. Among the specialty workspaces are Automation, Painting, Printing and Proofing, Typography, and Web. On the following page, you’ll learn how to create and save custom workspaces for different purposes.

**To choose a predefined workspace:**

From the **Workspace** menu on the Application bar, choose a predefined workspace. C

➤ The arrangement of panels on a computer with dual displays is saved as a single workspace. You could put all the panels in one display, or put the ones you use most often in one display and those you use less often in the other.

A blue horizontal drop zone bar appears as we drag a Color Guide/Gradient panel group upward into a Color/Swatches panel group.

Now the four color-related panels are in the same group.

C On the Workspace menu on the Application bar, user-defined workspaces are listed first, followed by the preset workspaces.
If the predefined workspaces don’t suit your needs, you can hide, show, collapse, or expand any of the panels or docks. Even better, instead of tediously repeating those steps each time you start a work session, why not save your custom settings as a workspace? Saved workspaces are available on the Workspace menu (on the Application bar) for all documents. You can save multiple workspaces for different kinds of tasks.

**To save a custom workspace:**

1. If you like, you can use any of the preset workspaces on the Workspace menu as a starting point. Configure the Illustrator workspace by doing any or all of the following:
   - Position the panels that you normally use where you want them, including the Tools panel and any library panels (such as any of the PANTONE color books). Put them in the desired groups and in the desired locations in one or more docks.
   - Expand any of the panel docks, or collapse them to icons or icons with labels. For instance, you could expand the panels that you use frequently in one dock, and collapse the ones you use less frequently to icons in another dock.
   - Expand any of the pickers, including any of those that open from the Control panel, such as the Swatches panel or the Brush Definition picker. For the Swatches panel, you can choose an option from the Show Swatch Kinds menu.
   - Choose a View (e.g., a thumbnail or swatch size) for any panel from its menu.
   - Open any tearoff toolbars for tool groups that you use frequently (such as for the type tools or for the Rectangle and its related tools).

2. From the Workspace menu on the Application bar, choose **Save Workspace**.

3. In the Save Workspace dialog, enter a descriptive Name for the workspace.

4. Click OK. Your workspace (and any other user-saved workspaces) will be listed on, and can be chosen from, the Workspace menu on the Application bar.

➤ You can’t save an artboard number, zoom level, or custom view as part of a workspace.
To rename, delete, or duplicate a saved workspace:

1. From the Workspace menu on the Application bar, choose Manage Workspaces.
2. In the Manage Workspaces dialog, do any of the following:
   - To rename a workspace, click the workspace name, then type the desired name in the field.
   - To duplicate a workspace, click an existing workspace, then click the New Workspace button. Rename the duplicate workspace, if desired (a good idea).
   - To delete a workspace, click the workspace name, then click the Delete Workspace button.
3. Click OK.

   If no workspaces are selected in the Manage Workspaces dialog when you click the New Workspace button, the new workspace will be based on the current state of the panels and other features of the Illustrator interface.

EDITING A SAVED WORKSPACE

If you want to edit an existing workspace, follow the instructions on the preceding page, except reenter the same name in the Save Workspace dialog. When the alert dialog appears, click Yes to overwrite the existing workspace.

This prompt appears if you try to save a new workspace under an existing name.
Unless noted otherwise, the entries in this index pertain to Illustrator.

**A**

**acquiring images**
- with Clipboard commands, 287
- with drag-and-drop method, 296
- by dragging from Bridge, 296
- methods, 287
- with Open command, 288
- with Place command, 289–291

**Add Anchor Point tool**, 41, 151

**AI (Adobe Illustrator) format**, 13

**AIT (Illustrator Template) format**, 13

**aligning**
- artboards, 11
- center points, 100
- objects, to pixel grid, 3, 82, 106
- objects, via buttons, 105–106
- objects, with existing objects, 79
- paragraphs, 264
- points, 164
- strokes on a path, 120
- symbols, to pixel grid, 359
- text, using tabs, 270

**Align panel**
- Align Objects buttons, 106
- Align To menu, 105–106
- defined, 43
- displaying, 105
- Distribute Objects buttons, 106
- Distribute Spacing menu, 106
- illustrated, 43, 105

**anchor points**
- absolute movement, 205
- adding manually, 151
- adding via command, 152
- adding with Pencil or Paintbrush tool, 153
- adding with Pen tool, 153
- adjusting when drawing with Pen tool, 282
- aligning, 164
- Control panel, 42
- converting corner to smooth, 149
- converting on existing paths, 284
- converting smooth to corner, 150, 283
- corner, 147, 149, 150, 283
- creating with Pen tool, 280, 281
- for curves, 281
- deleting, 154
- endpoint, 153, 165

**arrows**, creating, 121

**Artboard Options dialog**, 243

**Artboard creating**, 121

**Appearance attributes**
- adding to stroke or fill, 194
- applying to type, 276–278
- applying via in-panel links, 190–191
- copying, 196
- defined, 189
- deleting, 195
- editing, 194, 216, 218
- expanding, 196
- function of, 189
- hiding, 195
- restacking, 215
- targeting layers and, 178, 190, 192, 198, 276

**Appearance of Black preferences**, 390

**Appearance panel**
- Add New Effect menu, 145, 166, 199, 275, 340
- Add New Fill button, 193, 325, 351
- Add New Stroke button, 193, 277
- blue underlined effect listing, 200
- Brush Definition menu, 194, 195
- Characters label, 276, 351
- Clear Appearance button, 195, 213
- defined, 43
- Delete Selected Item button, 195, 200
- Fill and Stroke squares, 83, 114, 198
- icons, 192
- illustrated, 43, 189
- New Art Has Basic Appearance command, 191
- Opacity link, 194, 349, 350

**anti-aliasing**
- GIF format, 422
- JPEG format, 423
- in rasterizing objects, 206
- type, 420

**apostrophe style**, 260

**Application bar**
- Arrangement Documents menu, 26
- Go to Bridge button, 4
- illustrated, 24
- using, 24
- Workspace menu, 34, 35, 36

**Application frame**
- docking document windows into, 25
- in Macintosh, 23–24
- resizing, 24
- in Windows, 23

**area type**
- creating, 242–243
- entering inside object, 242
- options, 243
- selecting, 253
- vertical, rotating, 250

**See also type**

**Area Type Options dialog**, 243

**Area Type Tool**
- defined, 41
- in entering type in closed path, 242
- font and font size selection, 240
- uses, 239

**arrows**, creating, 121

**Artboard Options dialog**, 10, 12

**artboards**
- activating, 28
- adding, 7
- aligning, 11
- area outside of, 6
- boundaries, displaying, 6
- cycling among, 11
- defined, 3
- deleting, 9
- display options, 12
- duplicating, with contents, 8
- duplicating, without contents, 9
- fitting in document window, 28
- fitting to artwork, 9
- modifying, 10
- moving, 10
- naming, 12
- navigating among, 25

**Redefine Graphic Style command**, 216

**Reduce to Basic Appearance command**, 195

**Stroke link**, 190

**Type label**, 276, 351

**anti-aliasing**
- GIF format, 422
- JPEG format, 423
- in rasterizing objects, 206
- type, 420
number of, 3
options, choosing, 12
orientation, 10
placing symbols on, 355
rearranging, 11
repositioning, 10
requirement, 6
scaling, 10
selecting, 10
status bar display, 8

Artboards panel
defined, 7, 44
Delete Artboard button, 9
illustrated, 7, 44
New Artboard button, 8, 9
using to fit artboards in document window, 28

Artboard tool
adding artboards with, 7
defined, 40
deleting artboards with, 9
duplicating with, 8, 9

Art brushes
applied to path, 298, 307
creating and editing, 306–307
library, 299
stroke, scaling, 308
See also brushes

Art Brush Options dialog, 306–307
artwork
assigning colors to, 373–374
creating color groups from, 125
creating for the Web, 82
creating symbols from, 360
magnified, moving into view, 28
oversized, printing, 393
reducing colors in, 375
replacing colors in, 132

ASCII text format, 247

Assign Profile dialog, 21

Attributes panel
defined, 44
Don’t Show Center button, 101
illustrated, 44
Overprint Fill, 403
Overprint Stroke, 403
Reverse Path Direction buttons, 338

baseline shift, 272
bitmap images
acquiring, 287–296
colorizing, 133
converting into mosaics, 291
black
100% K (black), 403
knockouts, changing, 403
options for print and display, 390
rich, 402, 403
bleed
region, 6
values, 3, 394–395
blending modes
changing, 349–351
in EPS files, 412
in exporting to Photoshop, 424
in fill or stroke, 351
object, group, or layer, 350
restricting, 352
type, 351
blends
fill colors, 134
Live Paint groups from, 228
Blob Brush tool
combining objects with, 160
creating Live Paint groups with, 233
defined, 40
diameter, decreasing/increasing, 160
in drawing exercise, 161, 170
drawing with, 87
expanding Live Paint groups and, 238
options, 88
reshaping objects with, 160

BMP files, 419
bounding box
hiding and showing, 103
reorienting, 146
transforming with, 137
Bridge, 55–74
adding folders to Favorites panel, 61
cache, exporting and purging, 74
collections, 69–70
configuring panels, 64
displaying and hiding panels, 64
dragging images from, 296
file metadata, 61
filtering display of thumbnails, 72
Filter Items by Rating menu, 72
Filter panel, 72
finding files with, 68
getting to Illustrator from, 62
Go Back/Go Forward buttons, 60
Go to Parent or Favorites menu, 60
interface colors, 66
keywords, 73
launching, 4, 56
opening files from, 62
Open Recent File menu, 62
panels, 56
Path bar, 60, 72
previewing graphics in, 60–61
rating and labeling thumbnails, 71
reopening recently opened files with, 62
resizing thumbnails, 64
sorting thumbnails, 72
synchronizing color settings with, 20
thumbnail stacks, 67
window features, 56
window illustration, 57
workspaces, 58–59
workspaces, customizing, 64–65
workspaces, resetting, 66
workspaces, saving, 66

Bristle brushes
applied to path, 298
creating and editing, 309–310
shortcuts for changing size and opacity of, 311
on solid-color objects, 311–312
Bristle Brush Options dialog, 309–310
Brush Definition menu, 84, 85, 298, 300
brushes, 297–316
appending to Brushes panel, 299
applying to existing paths, 298
colorization methods, 313
creating library of, 316
deleting, 316
duplicating, 313
editing manually, 314
loading from library, 299
recoloring, 314
replacing, 314
restoring, 316
saving, 316
types of, 297–298
variations, creating, 304
See also Art brushes; Bristle brushes;
Calligraphic brushes; Pattern brushes; Scatter brushes

Brushes panel
appending multiple brushes to, 299
Brush Libraries menu, 316
brush selection, 85
default, 297
defined, 45
Delete Brush button, 316
index

435

display options, 300
illustrated, 45, 297
New Brush button, 302, 304
Options of Selected Object button, 312
Remove Brush Stroke button, 300
Show option, 300
using, 299–300

brush libraries
creating, 316
loading brushes from, 299
saving brushes in, 316

brush strokes
applying to paths, 298
Art brush, 306–308, 315
Bristle brush, 309–312, 315
Calligraphic brush, 302–303, 315
drawing, 85
editing, 312, 315
expanding, 301, 316
methods, 297
painting inside objects, 312
removing, 85, 300
restoring, 315
scaling, 315
Scatter brush, 304–305, 315
selecting objects that contain, 93
tints, 313

caps, stroke, 120–121
center points
aligning, 100
hiding and showing, 101

character style options, 300
illustrated, 45, 297
New Brush button, 302, 304
Options of Selected Object button, 312
Remove Brush Stroke button, 300
Show option, 300
using, 299–300

brush libraries
creating, 316
loading brushes from, 299
saving brushes in, 316

brush strokes
applying to paths, 298
Art brush, 306–308, 315
Bristle brush, 309–312, 315
Calligraphic brush, 302–303, 315
drawing, 85
editing, 312, 315
expanding, 301, 316
methods, 297
painting inside objects, 312
removing, 85, 300
restoring, 315
scaling, 315
Scatter brush, 304–305, 315
selecting objects that contain, 93
tints, 313

cache (Bridge), 74
calibration, display, 16
Calligraphic brushes
applied to path, 298
creating and editing, 302–303
library, 299
strokes, editing, 315
See also brushes

Calligraphic Brush Options dialog, 302–303
caps, stroke, 120–121
center points
aligning, 100
hiding and showing, 101

Character panel
accessing, 255
Anti-aliasing menu, 420
Baseline Shift option, 272
Character Rotation value, 250
defined, 45
Font menu, 240, 255
Font Size option, 240, 256
Horizontal Scale option, 256
illustrated, 45
Kerning option, 258
Leading option, 257
Strikethrough button, 255
Tracking option, 252, 258
Underline button, 255
Vertical Scale option, 256

Character Style Options dialog, 268
color blindness, 18
collection (Bridge)
adding thumbnails to, 70
creating, 69, 70
color plates, viewing, 402
selecting from Color panel, 402
selecting in New Document dialog, 3
settings, 17

Collections panel (Bridge)
defined, 56
Edit Smart Collection button, 69
New Collection button, 70

color blindness, 18
color groups
creating
from artwork, 125
via Color Guide panel, 130
from swatches, 125
via Recolor Artwork dialog, 370, 372, 374, 376
deleting, 374
Kuler, 131
renaming, 125
restacking, 125
saving, 130, 370
saving to Swatches panel, 372

Color Guide panel
adding colors to Swatches panel
from, 130
applying color variations via, 128–129
color variations with, 115
creating color groups from, 130
defined, 46
Edit or Apply Colors button, 369
Harmony Rules menu, 130
illustrated, 46
Limit Color Group to Colors in Swatch Library menu, 128
Save Color Group to Swatch Panel button, 130
Set Base Color to Current button, 115
using, 128–131
variation options, 128

Colorization Tips dialog, 313
color management, 15–22
color profiles, 16, 21
color settings selection, 17–19
color settings synchronization, 20
display calibration for, 16
introduction to, 15–16
onscreen proofing, 22
Print dialog options, 400
color models for Color panel, 117
color modes (document)
CMYK, 3
in color management, 17–18
RGB, 3
selecting for document, 113
Color panel
color model selection, 117
color selection, 117
defined, 46
Fill and Stroke squares, 114
illustrated, 46
temporary, 119, 190
Tint slider, 119
Color Picker, 115
color profiles
defined, 16
deleting, 21
changing, 21
embedding when saving files, 21
colors
applying
via Color Guide panel, 115, 128–129
via Color panel, 114, 117
via Color Picker, 115
via Eyedropper tool, 123
from a library, 118
via Swatches panel, 114
assigning via Recolor Artwork dialog, 373–374
blending fill, 134
copying between files, 126
DIC Color Guide, 118
fill, defined, 83, 111
gradient, editing, 320–321
for guides, 109, 383
inverting, 133
keeping within gamut, 117
limiting to library, 375
for output medium, 112–113
PANTONE, 118
for print output, 112–113
print settings, 397
process, 112–113
proofing, 22, 118
reducing in artwork, 375–376
Registration, 409
replacing, 132, 369–374
sampling, 123
shortcuts for applying, 116
spot, 112, 118, 412
stroke, defined, 83, 111
surprises, avoiding, 118
tint percentage, 119
TRUMATCH, 118
for Web output, 113
white and black, 115
See also Color Guide panel; Color panel; Swatches; Swatches panel
color separations, 396
color settings
selecting, 16, 17–19
synchronizing, 20
Color Settings dialog
accessing, 15, 17
alert, 20
Color Management Policies options, 16, 17–18
illustrated, 19
Settings menu, 17
Working Spaces options, 15, 17
color spaces
Adobe RGB, 17
ColorMatch RGB, 17
ColorSync RGB, 18
defined, 16
functions, 17, 19
Monitor RGB, 18
ProPhoto RGB, 17
sRGB IEC61966-2.1, 17
ColorSync RGB color space, 18
color themes. See Kuler panel
Color Universal Design guidelines, 18
combining objects
with Blob Brush tool, 160
with Compound Path command, 337–339
into compound shapes, 333
with Pathfinder commands, 334–336
with Shape Builder tool, 327–331
with Shape Mode commands, 167, 331–333
composite print, 396
compound paths
adding objects to, 338
with Compound Path command, 337–339
compound shapes versus, 336
Control panel, 42
creating, 337
defined, 337
filled areas, making transparent, 338
frontmost objects, 337
printing errors and, 337
releasing, 339
working with, 338–339
compound shapes
combining objects into, 333
compound paths versus, 336
expanding, 333
releasing, 333
selecting, 336
compression
Adobe PDF format, 415–416
JPEG format, 423
in optimizing files, 420
when saving files in AI format, 13
constrain angle, 139, 378–379
Content panel (Bridge)
defined, 56
displaying in compact window, 64
Edit Smart Collection button, 69
metadata display format, 65
in previewing graphics, 60–61
context menus, 38
Control panel
Align Objects buttons, 106
with anchor point selected, 42
Anchors: Remove Selected Anchor Points button, 154
Artboard Options button, 12
Brush Definition menu, 85, 190, 300
Connect Selected End Points button, 165
Convert Selected Anchor Points to Corner button, 284
Convert Selected Anchor Points to Smooth button, 149, 150
Cut Path at Selected Anchor Points button, 168
defined, 42
Display Options menu, 12
Distribute Objects buttons, 106
Document Setup option, 7, 354
Edit Symbol option, 361
Embedded option, 292, 293, 295
Expand option, 225, 237
Fill color square, 40, 83, 111, 114
Font menu, 240, 255
Font Style menu, 240, 255
Gap Options button, 236
with group selected, 42
Horizontal Align buttons, 164
illustrated, 42
Landscape button for artboards, 10
linked file options, 292
Live Paint option (for a Live Trace object), 226
Merge Live Paint option, 235
Move/Copy Artwork with Artboard button, 8, 9, 10
moving, 42
moving artwork via, 143
with object selected, 42
Opacity link, 349, 350
Portrait button for artboards, 10
Recolor Artwork button, 369, 373, 375
scaling artwork via, 143
Select Similar Options menu, 93, 119, 132
splitting paths via, 168
Stroke color square, 40, 83, 111, 114
Stroke Weight area, 83, 120
symbol set, 42
Tracing Options Dialog button, 221
Tracing Presets and Options menu, 220
Variable Width Profile menu, 85
Vertical Align buttons, 164
W, H, X, Y fields, 143
Convert Anchor Point tool, 41, 149, 150, 284
copying. See duplicating
corner points
converting smooth points to, 150, 282–284
converting to smooth points, 149, 282, 284
illustrated, 147
See also anchor points
corners, stroke, 121
crop marks
deleting, 408
producing, 408
registration color, 409
Crop Marks effect, 408
crosshairs cursor, 97, 378
CRT displays, 16
CS versions, saving files in, 13
curves
drawing with Pen tool, 281
good, creating, 151
number of points for, 281
reshaping, 148–150
Custom Transparency Flattener Options dialog, 405–406
D
dashed strokes, creating, 122
Delete Anchor Point tool, 41, 154, 170
Delete Brush Alert dialog, 316
DIC Color Guide, 118
Diffuse Glow effect, 208
direction handles
creating, 149
defined, 147
rotating, 150
selecting, 93, 150
uneven length, 157
Direct Selection tool
aligning points with, 164
defined, 40, 90
deleting anchor points with, 154
selecting or deselecting anchor points and segments with, 92
temporary access, 92
uses, 90
using, 92
discontinuous width points, 158
displays, 16
Distort & Transform effects
Free Distort effect, 278
Roughen effect, 152, 205
Transform effect, 145
Twist effect, 205
distortion, applying, 138
distributing objects, 105–106
Divide Objects Below command, 169
dividing objects
Divide button (Pathfinder panel), 334
Divide Objects Below command, 169
Pathfinder effect, 340
with Shape Builder tool, 330, 331
docks, panel
collapsing, 33
creating, 32
floating, 34
reconfiguring, 32
relocating, 32
document color profiles
coloring, 21
defined, 16
Document Info panel
defined, 47
displaying information with, 410
illustrated, 47
Document Raster Effects Settings dialog, 409
Document Raster Setting dialog, 206
documents
adding artboards to, 7–9
anatomy of Illustrator, 6
closing, 14
color mode, 3, 113
creating, 3
cycling among open, 25
information display about, 410
moving into view, 28
orientation, 3
preference for docking as tabs, 25
proofing onscreen, 22
saving in Illustrator (ai) format, 13
views, 30–31
zoom level, changing, 27
Document Setup dialog
Edit Artboards option, 7
Preset menu, 404
Transparency area, 354, 404–405
Units, 382
document windows
arranging, 26
artboard navigation controls, 28
docking into Application frame, 25
fitting artboards in, 28
multiple, displaying, 26
tabbed, 25
tabbed, converting to floating, 25
draw Behind mode, 75, 103, 176
drawing
with Blob Brush tool, 87, 161, 170
curves, with Pen tool, 281
freehand, 83–88
geometric objects, 76–82
for Live Paint groups, 228, 233
with Paintbrush tool, 85
with Pencil tool, 84
with Pen tool, 279–281
polygons, with Pen tool, 280
drawing modes, 40, 75, 103, 176, 312, 343, 347
Draw Inside mode, 176, 312, 343, 347
Draw Normal mode, 75, 176
Drop Shadow effect, 204, 277
duplicating
appearance attributes, 196
artboards, 8–9
brushes, 313
files between folders (Bridge), 74
gradient color stops, 321
group of objects, 102–103, 182
layers, 182
objects, 102–103, 182
objects between documents, 102–103
objects, in same document, 102, 103
sublayers, 182
swatches, 127
symbol instances, 357
type, 246
type objects, 246, 248
workspaces, 36

E
Edit Colors dialog, 375
editing
appearance attributes, 194, 216, 218
artboards, 10
Art brushes, 306–307, 314
Bristle brushes, 309–310
brushes manually, 314
brush strokes inside an object, 312
brush strokes on objects, 315
Calligraphic brushes, 302–303
character styles, 267, 268
document views, 31
global process color values, 132
gradients, 320–321
graphic styles, 215
grouped objects, 94
linked images, 292
paragraph styles, 267, 268
PDF presets, 407
print presets, 407
Scatter brushes, 304–305, 314
Smart Collections, 69
swatches, 375
symbols, 361
translating, 224, 407
transformations, 145
transparency flattener presets, 407
type characters, 246, 254
workspaces, 36

Edit menu
Adobe PDF Presets command, 407
Assign Profile command, 21
Color Settings command, 15, 17, 20
Copy command, 103, 246
Cut command, 95, 103, 246
Define Pattern command, 135
Edit Colors submenu
Blending commands, 134
Blending modes
Blending Transformations command, 134
Convert to Grayscale command, 133
Paste command, 95, 103, 246
Paste in All Artboards command, 103
Paste in Front command, 103
Paste in Place command, 103
Preferences submenu. See preferences
Print Presets command, 407
Tracing Presets command, 224, 407
Transparency Flattener Presets command, 407
Undo command, 113

Edit menu (Bridge)
Creative Suite Color Settings command, 20
Find command, 68, 69
Preferences submenu
General command, 61, 66
Thumbnails command, 65

Edit Selection dialog, 98
Edit Smart Collection dialog, 69
Edit Views dialog, 69
Effect Gallery
accessing, 198
applying Photoshop effects via, 207–208
illustrated, 207
panels, 207
restoring effects in, 208
using, 207–208

Effect menu
Convert to Shape effect, 201
Crop Marks effect, 408
Distort & Transform submenu
Free Distort effect, 278
Roughen effect, 152, 205
Transform effect, 145
Twist effect, 205
Document Raster Effects Settings command, 409
Effect Gallery, 207–208
illustrated, 198
Rasterize command, 206
Stylize submenu
Drop Shadow effect, 204, 277
Feather, 275
Inner Glow effect, 202
Outer Glow effect, 202
Round Corners effect, 78, 149
Scribble effect, 203
Warp submenu, 199
See also effects
effects, 197–208
accessing, 198
applying, 197–199
characteristics of, 197
Charcoal, 208
Convert to Shape, 201
Crop Marks, 408
defined, 197
Diffuse Glow, 208
Drop Shadow, 204, 277
editing, 200
Feather, 275
Free Distort, 278
Gran, 208
Inner Glow, 202
last-used, applying, 200
limiting, 198
multiple, applying, 198
Outer Glow, 202
Pathfinder, 340
Photoshop, 198, 207–208
Plastic Wrap, 208
previewing, 208
removing, 200
resolution for, 409
Roughen, 205
Round Corners, 78, 201
scaling, 139
Scribble, 199, 203
spot colors for, 204
Squeeze, 199, 203
Stamp, 208
textures, 208
Twist, 197, 205
Zig Zag, 166
ellipses
creating by dimensions, 76
creating by dragging, 76

Ellipse tool
in drawing exercise, 170
illustrated, 41
previous settings, 81
using, 76

embedded images
changing linked images to, 295
creating (Bridge), 296
going to, 293
linked images versus, 293
Photoshop effects, 293
replacing, 293
selecting, 292

Embedded Profile Mismatch alert dialog, 63
endpoints
adding segments to paths from, 153
connecting with segments, 165
creating by splitting paths, 168
joining, 165
See also anchor points
Enhanced Metafile (emf) format, 419
EPS files
defined, 411
format, 13
opening and placing, 291
overprints in, 412
saving, 411–413
saving in earlier formats, 413
spot colors, 412–413
EPS Options dialog, 412–413
Eraser tool
defined, 40
diameter, increasing/decreasing, 163
in erasing parts of objects, 161, 163
Essentials workspace (Bridge), 59, 66
Expand dialog
gradients, 326
symbol instances, 368
expanding
appearance attributes, 196
brush strokes, 301, 316
compound shapes, 333
gradients, into paths, 326
Live Paint groups, 237, 238
live tracing, 225
panels, 32
symbol instances and sets, 368
Export dialog, 418, 424
exporting
cache (Bridge), 74
EPS files, 411–413
formats, 419
Illustrator files, 418–419
PDF files, 414–417
to Photoshop, 424
semitransparent objects, 404–406
tracing presets, 224
transparency, 351
extracting shapes, 329
Eyedropper tool
applying colors with, 123
defined, 40
options, 123
sampling colors with, 123
temporary, 230
F
Favorites panel (Bridge)
adding folders to, 61
defined, 56
for quick file searches, 68
file formats
AI, 13
AIT, 13
BMP, 419
EMF, 419
EPS, 13, 291, 411–413
FXG, 13
GIF, 420, 422
importable, 288
JPEG, 420, 423
PDF, 13, 288, 414–417
Photoshop (.psd), 424
PNG, 419
PSD, 288
SVG, 13
SVG Compressed, 13
TIFF, 291, 419
WMF, 419
File Handling & Clipboard preferences, 292, 389
File Info dialog (Bridge), 73
File menu
Document Color Mode submenu, 113
Export command, 352, 418, 424
New command, 3
New from Template command, 5
Open command, 55, 220, 288
Open Recent Files submenu, 55
Place command, 220, 247, 289
Print command, 392, 398
Revert command, 14
Save a Copy command, 14, 411, 414
Save As command, 113, 411, 414
Save as Template command, 5
Save command, 13, 14
Save for Microsoft Office command, 419
Save for Web & Devices command, 421–423
File menu (Bridge), 288, 289
files
assigning keywords to (Bridge), 73
copies of, saving, 14
deleting (Bridge), 74
exporting, 411–424
finding (Bridge), 68
flatness setting, 398
handling preferences, 389
managing (Bridge), 74
metadata (Bridge), 61
missing, relinking to collections (Bridge), 70
moving/copying (Bridge), 74
open, closing, 14
opening as untitled documents, 5
opening from Bridge, 62
opening from Illustrator, 55
opening from Macintosh Desktop/Windows Explorer, 55
optimizing for the Web, 420–423
recently opened, reopening from Bridge, 62
recently opened, reopening from Illustrator, 55
renaming (Bridge), 74
resaving, 14
reverting to last saved version, 14
saving as templates, 5
saving in EPS format, 411–413
saving in Illustrator (ai) format, 13
saving in PDF format, 414–417
thumbnails, displaying (Bridge), 60
fill and stroke colors
applying
to clipping paths, 346
via Color Guide panel, 115
via Color panel, 117
via Color Picker, 115
via Eyedropper tool, 123
from a library, 118
to Live Paint groups, 230, 231
via temporary Swatches panel, 83, 114
current/last selected object, 111
display of, 111
Live Paint Bucket tool for, 231
None, 83, 114
tint percentage, 119
white and black, 115

fill colors
blending, 134
saving as swatches, 116
See also colors; fill and stroke colors
fill colors
blending, 134
saving as swatches, 116
See also colors; fill and stroke colors
fills
adding appearance attributes to, 194
blending mode, changing, 351
defined, 83
multiple attributes, applying, 193
opacity, changing, 351
overprint, 403
patterns, 135–136
See also gradients
Filmstrip workspace (Bridge), 66
Filter panel (Bridge), 72
Find dialog (Bridge), 68
Fit Headline command, 259
Flash Catalyst, Flash Professional, 418
flatness, 398
Flatten Artwork command, 188
Flattener Preview panel
defined, 47
Highlight menu, 406
illustrated, 47, 406
Rasters/Vectors slider, 406
flattening
defined, 398
flatness versus, 398
layers, 188
options, 401
selective, 407
semitransparent objects and, 404–406
settings, previewing, 406
Flatten Transparency command, 407
FOCOLTONE process colors, 118
Folder panel (Bridge)
defined, 56
displaying folder contents, 60
folders (Bridge)
adding to Favorites panel, 61
contents, displaying, 60
creating, 74
deleting, 74
moving/copying files between, 74
Font Problems alert dialog, 63
gap
Gap Options dialog, 236
General preferences, 378–379
Anti-aliasing Artwork option, 378
Append [Converted] Upon Opening Legacy Files option, 378
Constrain Angle option, 139, 378, 379
Corner Radius option, 378
Disable Auto Add/Delete option, 151, 378
Double Click to Isolate option, 94, 378
illustrated, 379
Keyboard Increment option, 378
Reset All Warning Dialogs option, 378
Scale Strokes and Effects option, 139, 315, 378
Select Same Tint % option, 119, 378
Show Tool Tips option, 378
Transform Pattern Tiles option, 139, 378
Use Japanese Crop Marks option, 378
Use Precise Cursors option, 39, 97, 378
Use Preview Bounds option, 105, 143, 378
See also preferences
General preferences (Bridge), 61, 66
GIF format
defined, 420
optimizing files in, 422
settings, 422
transparency and, 420, 422
See also optimizing files for Web
glyphs, 261–262
Glyphs panel
defined, 48
illustrated, 48
using, 261
gradient libraries, 318
Gradient panel
Add to Swatches button, 319, 322
creating gradients via, 319
defined, 48
editing gradients via, 325
Gradient Fill square, 318, 322
illustrated, 48, 325
gradients, 317–326
angle of, 323, 324
applying, 317–321
applying to strokes, 322, 336
applying to type, 320
applying via temporary Swatches panel, 114
colors, adding, 320
colors, distributing, 321
colors, opacity, 321, 325
colors, reversing order, 319, 325
color-separating, 397
creating, 319
editing, 320–321, 325
expanding into paths, 326
filling objects with, 318, 319
length, 323, 324
linear, 319, 323
loading onto Swatches panel, 318
naming, 319
position, 323, 324
radial, 319, 324
reapplying, 322
saving, as swatches, 322
scaling, 323
shape, 324
spreading across multiple objects, 325
starting/ending colors, swapping, 319
stops, duplicating, 321
stops, recoloring, 320
stops, removing, 321
stroke colors and, 115, 336
Gradient tool
annotator, 320, 321, 323–325
defined, 40
Grain effect, 208
Graphic Style Options dialog, 215
graphic styles, 209–218
adding to existing attributes, 214
adding to Graphic Styles panel, 211
applying, 210, 212
applying to layers, 212
applying with Symbol Styler tool, 367
basics, 209–210
benefits, 210
breaking links to, 218
creating, 215
custom libraries, creating, 218
default, establishing, 213
defined, 209
deleting, 217
illustrated examples, 210, 214
loading from library, 211
merging, 215
modifying, 215
multiple, adding, 211
redefining, 216–217
removing, 213
Graphic Styles panel
adding styles to, 211
Break Link to Graphic Style button, 218
Default Graphic Style thumbnail, 213
defined, 49
Delete Graphic Style button, 217
Graphic Styles Library menu, 211
illustrated, 49
New Graphic Style button, 215
Override Character Color option, 212
removing styles from, 218
temporary, 212
view, changing, 211
Grayscale color model, 117
Grayscale images, colorizing, 133
grid
illustrated, 110
preferences, 383
showing, 110
snapping objects to, 110
See also pixel grid
groups
adding objects to, 95
applying gradients to, 325
blending mode of, changing, 350
color, 369–370
Control panel, 42
crop marks, 408
duplicating, 102–103, 182
duplicating objects in, 102
editing, 94
Isolate Blending option for, 352
isolating, 94
Knockout Group option for, 353
Layers panel, deleting, 175
Layers panel, selecting, 176–177, 180
Live Paint, 226, 227–238
merging, 187
moving, 99, 185
opacity, changing, 350
putting objects into, 94
removing brush strokes from, 300
removing graphic styles from, 213
restacking, 181
selecting, 180
selecting objects in, 180
targeting, 190, 353
trim marks, 408
ungrouping, 95
untargeting, 191
working with, 94–95
Group Selection tool
defined, 41
uses, 90
guides
artboard, 12
clearing, 109
color, 109
creating, from objects, 108
hiding and showing, 109
locking, 109
preferences, 383
releasing, 108
relocking, 109
ruler, 107
tips for working with, 109
unlocking, 109
Guides & Grid preferences
Grid options, 82, 110, 383
Guides options, 383
illustrated, 383
See also preferences
H
Hand tool
defined, 40
moving document into view with, 28
temporary, when using a type tool, 247
hanging indents, 265
hanging punctuation, 270
HKS process colors, 118
HSB color mode, 117
hyphenation
applying, 263
options, 263
preferences, 386
icons, panel, 38
Illustrator
dragging and dropping images into, 296
files, exporting, 418–419
getting to from Bridge, 62
launching (Macintosh), 1
launching (Windows), 2
opening files from, 55
quitting/exiting, 14
welcome screen, 1, 2
Illustrator Options dialog, 13
images
acquiring, 287–296
bitmap, 287, 291
colorizing, 133
dragging and dropping, 296
embedded, 292, 293
linked, 292–295
multilayer, importing, 290
raster, 220
single-layer, importing, 290
text, 247
TIFF images, 291
tracing presets, 224
indentation, paragraph, 265
InDesign, transparency settings, 404
Info panel, 49
information, document, 410
Inner Glow effect, 202
inserting
glyphs, 261
OpenType characters, 262	tabs, 270
type characters, 254
inverting
colors, 133
selections, 98
Isolate Blending option, 352
isolation mode
editing clipping set objects in, 345
editing grouped objects in, 94
editing individual objects in, 96
exiting, 94, 95, 361
getting into, 154
selecting groups and, 180
J
joining paths, 165
JPEG format
  compression, 423
  defined, 420
  optimizing files in, 423
  settings, 423
  See also optimizing files for Web
Justification dialog, 259
K
kerning, 258
keywords (Bridge)
  assigning, 73
  creating, 73
  defined, 56, 73
  filtering thumbnails based on, 72
Keywords panel (Bridge), 56, 73
Knockout Group option, 353
Kuler panel, 131, 375
L
labels, thumbnail (Bridge)
  assigning, 71
  filtering thumbnails based on, 72
Lasso tool
  defined, 40
  pointer, 97
  selecting or deselecting points and segments with, 96
  uses, 90
launching Bridge, 56
launching Illustrator, 1–2
  in Macintosh, 1
  in Windows, 2
layer-level clipping sets
  creating, 344
  releasing, 348
  selecting objects in, 346
  See also clipping sets
Layer Options dialog, 183
layers
  adding below existing ones, 173
  applying graphic styles to, 212
  blending mode, changing, 350
  collecting to new layer, 185
  creating, 173–174
  deleting, 175
  duplicating, 182
  flattening, 188
  hiding and showing, 184
  locking, 183
  merging, 187
  moving objects to, 182, 186
  multiple, moving, 185
  multiple, selecting, 177
  objects, selecting/deselecting via, 178
  objects, selecting on multiple layers, 179
  opacity, changing, 350
  options, 183
  pasting to original, 103
  releasing objects to, 186
  removing brush strokes from, 300
  removing graphic styles from, 213
  renaming, 174
  restacking, 181
  selecting, 176–177
  selecting for printing, 392
  sublayers, creating, 174
  targeting, 190, 192
  targeting for appearance edits, 192
  top-level, creating, 173
  unlocking, 183
  untargeting, 191
  view, shortcuts for changing, 185
Layers panel
  adding objects to groups via, 95
  clipping paths on, 341
  Collect in New Layer command, 185
  defined, 49
  duplicating objects via, 182
  Flatten Artwork command, 188
  functions, 171–172
  group list, expanding, 180
  hiding and showing objects via, 184
  illustrated, 49, 171
  Locate Object command, 179
  locating listings on, 179
  locking and unlocking guides in, 109
  Make/Release Clipping Mask button, 344, 348
  Merge command, 187
  New Layer button, 173, 182
  New Sublayer button, 174
  options, 172–173
  Release to Layers (Build) and (Sequence) commands, 186
  restacking via, 181
  selecting listings on, 176–177
  selecting objects via, 178–180
  target circle, 190, 192, 198
  visibility icon, 184
Layers Panel Options dialog, 172
LCD displays, 16
leading, 257
legacy AI formats, 13
letter spacing, 259
library panels
  applying colors from, 118
  brush, 299, 316
  cycling through, 118
  option to redisplay on relaunch, 299
  gradient, 318
  graphic style, creating, 218
  limiting colors to in Recolor Artwork dialog, 375
  loading graphic styles from, 211
  swatch, 118, 127
  symbol, 356–357
Light Table workspace (Bridge), 59
linear gradients. See gradients
line segments
  constraining, 81
  creating with values, 81
  dashed or dotted, 122
Line Segment tool
  defined, 40
  Options dialog, 81
  using, 81
linked images
  changing to embedded images, 295
  editing, 292
  embedded images versus, 293
  going to (displaying), 293
  importing via Bridge, 296
  information, viewing, 295
  locating or replacing, upon opening a document, 294
  managing, 292–295
  missing (locating or replacing), 294
  Photoshop effects, 293
  replacing, 293
  updating, 292, 294
Links panel
  defined, 50, 292
  display options, 295
  Edit Original button, 292
  Embed Image command, 295
  getting image info via, 295
  Go to Link button, 293
  illustrated, 50, 292
  Panel Options command, 295
  Relink button, 293, 294
  sort order, 295
  temporary, 292
  Update Link button, 294
warning icon, 294
Live Paint Bucket Options dialog, 229
Live Paint Bucket tool
defined, 41
in Live Paint group creation, 228
modifying edges with, 231
options, 229
recoloring faces with, 230
as temporary Eyedropper tool, 230
using, 229–231
Live Paint groups, 227–238
adding faces and edges to, 235
from Blob Brush versus Pencil tool strokes, 233, 238
characteristics of, 227
converting Live Trace objects to, 226
creating, 228
documents
flooding, 231
modifying, 231
recoloring, 231
expanding, 237, 238
faces
flooding, 230
recoloring, 230
gap options, 236
moving areas in, 234
releasing, 237
reshaping, 234
selecting faces or edges in, 232
Live Paint Selection Options dialog, 232
Live Paint Selection tool
defined, 41
options, 232
selecting faces or edges with, 232
using, 232
Live Trace objects, 219–226
converting to Live Paint groups, 226
converting to paths, 225
releasing, 224
Tracing Options, 221–223
tracing presets, 224, 407
tracing raster images, 220
Locking
guides, 109
layers or objects, 183
Macintosh
Application frame, 23–24
Desktop, opening files from, 55
launching Illustrator in, 1
quitting Illustrator in, 14
Magic Wand panel
defined, 50
illustrated, 50
using, 97
Magic Wand tool
defined, 40
options, 97
uses, 90
using, 97
Manage Workspaces dialog, 36
masked objects
adding to, deleting from clipping sets, 347
in clipping sets, 341–344
releasing from clipping sets, 348
selecting, 93, 345–346
measurement units, changing, 382
merging
graphic style attributes, 215
groups, layers, or sublayers, 187
metadata (Bridge), 65
Metadata panel (Bridge), 56, 61
Microsoft Office, exporting to, 419
Microsoft Word Options dialog, 247
Missing Profile alert dialog, 63
Monitor RGB color space, 18
moving
anchor points, 148
artboards, 10
Control panel, 42
files between folders (Bridge), 74
groups, 99
Live Paint group areas, 234
magnified artwork in window, 27
objects
by dragging, 99
via Control panel, 143
to layers, 182
via Transform Each command, 144
via Transform effect, 145
via Transform panel, 142–143
panels, 32
panels (Bridge), 64
path segments, 148
sublayers, 185
tab markers, 271
thumbnail stacks (Bridge), 67
type characters, 246
width points, 157
N
Navigator panel
defined, 50
illustrated, 50
moving document areas via, 28
New Brush dialog, 304
New Color Group dialog, 125
New Document dialog, 3
New from Template dialog, 5
New Swatch dialog, 127
New View dialog, 31
New Workspace dialog (Bridge), 66
nonprinting character symbols, 264
Normal Screen Mode, 29
Object menu
Arrange > Send to Current Layer command, 182
Artboards submenu
Create Artwork Bounds command, 9
Create Selected Art command, 9
Clipping Mask submenu
Make command, 342
Release command, 348
Compound Path submenu
Make command, 336, 337, 338
Release command, 339
Create Object Mosaic command, 291
Create Trim Marks command, 408
Expand Appearance command, 196, 301
Expand command, 326, 368
Flatten Transparency command, 407
Live Paint submenu
Make command, 228
Release command, 237
Live Trace command, 224
Path submenu
Add Anchor Points command, 152
Clean Up command, 241, 280
Divide Objects Below command, 169
Offset Path command, 104
Outline Stroke command, 322, 336
Rasterize command, 113, 206
Text Wrap command, 274
Transform > Reset Bounding Box command, 146
Ungroup command, 95

**objects**
- adding to clipping sets, 347
- adding to compound paths, 338
- adding to groups, 95
- adding to selections, 91
- aligning, 79
- aligning to pixel grid, 3, 82, 106
- aligning via buttons, 105–106
- aligning using Smart Guides, 100–101
- applying graphic styles to, 212
- before creating (things to do), 75
- blending mode, changing, 349–351
- center point, hiding/showing, 101
- collecting into new layer, 185
- combining, 167, 332
- combining as compound shapes, 333
- combining with Blob Brush tool, 160
- Control panel, 42
- copying and pasting as pixels to Photoshop, 424
- creating guides from, 108
- crop marks for, 408
- cutting with Divide Objects Below command, 169
- default appearance settings, 191
- deleting, 75, 175
- deleting from clipping sets, 347
- deselecting all, 98
- deselecting, in layer, 178
- dimensions readouts, 77
- distributing, 105–106
- dividing, 330, 334
- duplicating
  - between documents, 102–103
  - via Layers panel, 182
  - in same document, 102
- erasing parts of, 163
- exporting as Smart Objects, 424
- extracting from, 329
- filling with gradients, 318
- grouped, editing, 94
- hiding and showing, 184
- highlighting (Smart Guides), 100–101
- information display about, 410
- isolating, 94, 96, 346
- Live Paint, converting to, 228
- Live Trace, converting to, 225–226
- locking, 183
- masking, 342–344
- moving, 99
- moving, to layer(s), 182, 185, 186
- opacity, changing, 349–351
- painting brush strokes inside, 312
- putting into groups, 94
- rasterizing, 206
- readout display, 77
- reference point, resetting, 141
- releasing to layers, 186
- removing brush strokes from, 300
- removing graphic styles from, 213
- reshaping
  - with Blob Brush tool, 160
  - with commands, 166–167
  - in freehand style, 161
  - with Pencil or Paintbrush tool, 155
  - restacking, 181
  - rounding corners of, 78
- selecting, 89–93
  - all, 98
  - by command, 92–93
  - on different layers, 179
  - via Layers panel, 178–180
  - by path only, 91
  - type objects, 93, 253–254
- selectively flattening, 407
- semitransparent, 404–406
- smoothing edges of, 160
- snapping, to grid, 30, 110
- spreading gradients across, 325
- subtracting from selection, 91
- targeting, 178, 190, 192, 198, 276
- tracing, releasing, 224
- transforming via bounding box, 137
- trim marks for, 408
- underlying, selecting, 91
- ungrouping, 95
- unlocking, 183
- untargeting, 191
- wrapping text around, 274
- See also type objects

**Offset Path dialog**, 104

**opacity**
- Bristle brush, 311
- fill, 351
- gradient color, 325
- group, 350
- Knockout Group option, 353
- layer, 350
- object, changing, 349–351
- setting, replacing, 132
- stroke, 351

**open paths**
- adding to with Pencil or Paintbrush tool, 153
- adding to with Pen tool, 153
- defined, 147
- drawing, 84, 85
- versus closed paths, 75
- See also paths

**Open PDF dialog**, 288

**OpenType panel**
- defined, 51
- illustrated, 51
- using, 262

**optimizing files for Web**, 420–423
- formats, 420
- in GIF format, 422
- image size and compression, 420
- issues to address before, 420
- in JPEG format, 423
- preview controls, 421
- type and, 420

**orientation**
- artboards, 10
- documents, 3
- in printing, 392

**Outer Glow effect**, 202

**Outline Stroke command**, 336

**outlines, type**, 273

**Outline view**, 30

**Out of Gamut icon**, 115

**output.** See exporting; printing

**overflow type**, 241, 248–249

**overprints**
- changing black knockouts to, 403
- in EPS files, 412
- options, 401

**P**

**Paintbrush tool**
- adding to open paths with, 153
- default settings, restoring, 86
- defined, 40
- options, 86
- paths, removing strokes/width profiles from, 85
- reshaping with, 155

**panels**, 37–54
- Align, 43, 105–106
- Appearance, 43, 166, 189–196, 199, 275–278, 340
- Artboards, 7, 8, 9, 28, 44
- Attributes, 44, 101, 338, 403
Index

Brushes, 45, 297, 299–300
Character, 45, 252, 255–258, 272
Character Styles, 46, 266, 267, 269
closing, 32
Color, 46, 117, 119
Color Guide, 46, 115, 128–130
Document Info, 47, 410
expanding and collapsing, 32
Flattener Preview, 47, 406
floating, 34
Glyphs, 48, 261
Gradient, 48, 318, 319, 322, 325
Graphic Styles, 49, 211–213, 217–218
hiding and showing, 32, 39
icons, 38
Info, 49
Kuler, 131
Layers, 49, 93, 171–173, 178–182,
188, 192
library, 118, 211, 318, 356
Links, 50, 292–295
Magic Wand, 50, 97
maximizing and minimizing, 32
moving, 32
Navigator, 28, 50
OpenType, 51, 262
options, showing and hiding, 43
Paragraph, 51, 255, 263–265, 270
Paragraph Styles, 52, 266–267, 269
Pathfinder, 52, 167, 332–336
reconfiguring, 32
resetting, 34
Separations Preview, 52, 391, 402–403
showing and hiding, 32, 39
Stroke, 53, 120–122, 156
Swatches, 53, 114, 116, 118,
124–127, 132
Symbols, 53, 355–358
Tabs, 54, 271
temporary, opening, 42
Tools, 39–41
Transform, 54, 142–143
Transparency, 54, 191, 349–353
type, shortcuts for opening, 51
values, entering, 38
values, selecting, 37
panels (Bridge)
Collections, 56
configuring, 64
Content, 56, 60–61, 65
displaying and hiding, 64
Favorites, 56
Filter, 72
Folders, 56, 60
Keywords, 56
Metadata, 56, 61
Preview, 56, 58–61
PANTONE colors, 118
Paragraph panel
accessing, 255
Adobe Every-line Composer and Adobe
Single-line Composer options, 263
alignment buttons, 264
defined, 51
First-Line Left Indent value, 265
illustrated, 51
Justification command, 259
Left Indent/Right-Indent values, 265
Roman Hanging Punctuation
command, 270
Space Before Paragraph/Space After
Paragraph options, 265
paragraphs
alignment, 264
attributes, changing, 264
defined, 264
indentation, 265
nonprinting symbol, 264
selecting, 254
soft and hard returns, 264
spacing between, 265
Paragraph Style Options dialog, 268
paragraph styles
applying, 267
copying between documents, 269
creating, 266
defined, 266
deleting, 269
editing, 267, 268
illustrated, 266
options, 268
overrides, removing, 267
using, 266–269
Paragraph Styles panel
creating styles with, 266
defined, 52
illustrated, 52
Load Paragraph Styles command, 269
New Style button, 266
Redefine Paragraph Style command,
267
paste commands, 103
Paste Options dialog, 296
Path bar (Bridge), 60, 72
Path Eraser tool, 41, 163
Pathfinder commands
applying, 334–335
guidelines, 334
Pathfinder effects, 340
Pathfinder Options dialog, 340
Pathfinder panel
Crop button, 335
defined, 52
Divide button, 334
Exclude button, 332, 333
Expand option, 333
illustrated, 52
Intersect button, 332, 333
Merge button, 335
Minus Back button, 335
Minus Front button, 332, 333
Outline button, 335
Release Compound Shape command, 333
Shape Mode buttons, 331, 332, 333
Trim button, 335
Unite button, 167, 332, 333
paths
adding arrowheads and tails, 121
applying brushes to, 84, 298
applying variable width profiles to, 156
building blocks of, 147
clipping, 341–348
closing, 165
combining, 327–340
compound, 337–339
contour, changing, 84, 85
Control panel, 42
converting tracing to, 225
corners, rounding, 149
deleting points from, 154
duplicates, offsetting, 104
joining, 165
removing brush strokes or variable
width profiles from, 85, 156
selecting objects by, 91
splitting, 168
See also objects; reshaping
path type
creating, 244–245
flipping and repositioning, 244
illustrated, 244, 245
options, 245
selecting, 254
See also type
Pattern brushes
applied to path, 298
library, 299
Scatter brushes versus, 298

Pattern fills
applying via temporary Swatches panel, 114
creating, 135
defining, 135
editing, 136
expanding, 136
repositioning, 136
transforming, 139, 141

PDF files
format, 13
opening into Illustrator, 288
presets, 407
saving Illustrator files as, 414–417

Pencil tool
adding to open paths with, 153
creating Live Paint groups with, 233
default settings, restoring, 86
defined, 40
drawing with, 84
expanding Live Paint groups and, 238
options, 86
paths, removing strokes/width profiles from, 85
reshaping objects with, 155

Pen tool, 279–286
adding to open paths with, 153
adjusting points while drawing paths with, 282
converting points while drawing, 283
defined, 40
drawing a knife with, 285–286
drawing curves with, 281
drawing polygons with, 280
drawing with, 279–281
as temporary Convert Anchor Point tool, 150, 284

Perspective, applying, 138
Photoshop
adjustment layers from, 291
copying and pasting objects as pixels into, 424
dragging and dropping selections from, 296
EPS files, 291
exporting Illustrator files to, 424
images for Illustrator text wraps, 274
import options, 290–291
layer masks, 296
PSD files, 290–291
Smart Object layer feature, 424
Photoshop effects
accessing, 198
applying via Effect Gallery, 207–208
See also effects
Photoshop Export Options dialog, 424
Photoshop Import Options dialog, 290–291, 295

Pixel grid
aligning objects to, 3, 82
aligning symbols to, 359
snapping objects to, 30, 110
viewing onscreen, 82
Pixel Preview view, 30, 82
Place command
function of, 289
importing files via, 289–291
for raster images, 220
Place dialog, 247
plain text format, 247
Plastic Wrap effect, 208
Plug-ins & Scratch Disks preferences, 387
PNG files, 419
point type
creating, 240
creating shadows for, 275
defined, 240
illustrated, 240
selecting, 254
See also type
polygons
creating by clicking, 78
creating by dragging, 79
drawing with Pen tool, 280
Polygon tool
illustrated, 41
previous settings, 81
using, 78–79
preferences, 377–390
Appearance of Black, 390
File Handling & Clipboard, 292, 389
General, 39, 94, 97, 105, 139, 378–379
Guides & Grid, 30, 82, 383
Hyphenation, 263, 386
opening, 377
Plug-ins & Scratch Disks, 387
resetting all, 377
Selection & Anchor Display, 91, 92, 107, 380
Slices, 385
Smart Guides, 77, 100, 280, 281, 384–385
Type, 381
Units, 382
User Interface, 388
preferences (Bridge), 65, 66
presets
Adobe PDF, 407, 414, 417
creating, 407
ingesting, 407
file optimization settings, 422, 423
new document, 3
tracing, 220–221, 223–224, 407
transparency flattener, 404–405, 407
width profile, 159
Preview panel (Bridge)
cycling artboards in, 61
defined, 56
illustrated, 60
Preview view, 30
Preview workspace (Bridge), 59
Print dialog, 392–393
Advanced options, 401
Color Management options, 400
General options, 393–394
Graphics options, 398–399
Marks and Bleed options, 394–395
Output options, 396–397
Summary options, 401
printers
color management, 400
non-PostScript, 401
resolution, 397
printing, 391–410
on black-and-white printer, 392
bleed values, 394
color bars, 394
with color management, 400
on color printer, 392
colors for, 112–113
hidden layers, 184
layers, 392
oversized artwork by tiling, 393
registration marks, 394
semitransparent objects, 404–406
settings for individual colors, 397
settings, saving, 395
settings summary, 401
trim marks, 394
process colors, 112–113
appending, 126
changing from nonglobal to global, 132
deleting swatches for, 127
editing values of, 132
FOCOLTONE, 118
HKS, 118
PANTONE, 118
proofing, 118
swatches, replacing, 132
tint percentage, changing, 119
TRUMATCH, 118
See also spot colors
profiles, stroke, 156
applying, 156
default, restoring, 156, 159
width preset, 159
proofing
colors, 118
documents onscreen, 22
Proof Setup dialog, 22
PSD files
exporting files as pixels to, 424
importing, 288–291
See also Photoshop
punctuation
hanging, 270
Smart, 260
Q
quotation marks style, specifying, 260
R
radial gradients. See gradients
raster images. See images
Rasterize dialog, 113, 206
Rasterize Options dialog, 419
rasterizing path objects, 206
ratings, thumbnail (Bridge), 71, 72
Rearrange Artboards dialog, 11
Recolor Artwork dialog
accessing, 369
assigning colors with, 373–374
Assign tab, 373, 375
Color Mode menu, 370, 371
Color Reduction Options button, 376
Colors menu, 375
color wheel, 371–372
creating color groups with, 369–370
Delete Color Group button, 374
Get Colors from Selected Art button, 370, 371, 376
Harmony Rules menu, 370, 371, 373
illustrated, 370
Link Harmony Colors button, 371
New Color Group button, 370, 372, 376
Preset menu, 376
Recolor Art button, 369, 371
reducing artwork colors with, 375–376
Show Color Group Storage button, 370
Unlink Harmony Colors button, 371
recoloring
brushes, 314
brush strokes, 315
creations, 346
by dragging, 119
faces, with Live Paint Bucket tool, 230
Live Paint groups, 231
live tracing, 221–222
type, 240
type selection for, 117
See also colors; Recolor Artwork dialog
Recolor Options dialog, 376
rectangles
creating by dimensions, 76
creating by dragging, 76
creating type in, 241
creating with Type tool, 241
rounded, 77
Rectangle tool
defined, 40
previous settings, 81
using, 76
redefining graphic styles, 216–217
redefining type styles, 267
reflecting objects
with Free Transform tool, 138
with Reflect tool, 140–141
shadows, 275
via Transform Each command, 144
via Transform effect, 145
Reflect tool
defined, 41
options, 141
in shadow reflection, 275
using, 140–141
Registration color, 409
registration marks, 394
registration point, 359, 361, 363
Rendering Intents, 22
Reshape tool, 41, 162
reshaping, 147–170
with Blob Brush tool, 160
with commands, 166–167
curves, 148
in freehand style, 161
Live Paint groups, 234
object guides, 108
with Paintbrush tool, 155
with Pencil tool, 155
with Reshape tool, 162
shortcuts to select tools for, 152
strokes with Width tool, 157
resolution
for effects, 409
printer, 397
RGB color mode
changing document mode to, 113
Color Management Policies for, 16
selecting from Color panel, 117
selecting in New Document dialog, 3
settings, 17
Working Spaces options for, 15
Rotate tool
defined, 40
options, 141
using, 140–141
rotating
with bounding box, 137
direction handles, 150
with Free Transform tool, 138
with Rotate tool, 140–141
symbol instances, 365
with Transform panel, 142–143
type, 250
Roughen effect, 205
Round Corners effect, 78, 201
Rounded Rectangle tool
illustrated, 41
previous settings, 81
using, 77
RTF text format, 247
rulers
choosing color for guides from, 383
choosing units for, 382
creating guides for, 107
showing and hiding, 107
S
Save Adobe PDF dialog, 414–417
Save as Template dialog, 5
Save for Web & Devices dialog, 421–423
2-Up tab, 422, 423
4-Up tab, 421
GIF optimization options, 422
illustrated, 421
JPEG optimization options, 423
Optimized File Format menu, 422, 423
Preview in Default Browser button, 421
Select Browser menu, 421
Save Optimized As dialog, 422, 423
Save Selection dialog, 98
Save Workspace dialog, 35
saving
brush libraries, 316
color groups, 125, 130, 131, 370, 372, 374, 376
colors as swatches, 116
document views, 31
in EPS format, 411–413
file copies, 14
files in earlier CS versions, 13
files in Illustrator (ai) format, 13
files in PDF format, 414–417
gradients as swatches, 322
graphic style libraries, 218
patterns, 136
print settings, 395
selections, 98
swatch libraries, 127
symbol libraries, 361
tracing presets, 233
for the Web, 421–423
workspaces, 35
workspaces (Bridge), 66
Scale tool
defined, 40
in drawing exercise, 170
options, 141
with type, 256
using, 140–141
scaling
arrowheads, 121
artboards, 10
art brush strokes, 308
with bounding box, 137
brush strokes and effects, 315, 378
with Control panel, 143
with Free Transform tool, 138
gradients, 323
with Scale tool, 140–141
symbols, 252
with Transform Each command, 144
with Transform panel, 142–143
type, 256
Scatter brushes
applied to path, 298
creating, 304
editing, 304–305
library, 299
Pattern brushes versus, 298
strokes, editing, 315
See also brushes
Scatter Brush Options dialog, 304–305
Scissors tool
defined, 41
splitting paths with, 168
scratch disks, 387
screen modes, 29
Scribble effect, 199, 203
segments, path
moving to reshape paths, 148
selecting with Direct Selection tool, 92
selecting with Lasso tool, 96
Select a File to Import dialog, 269
Select a Library to Open dialog, 126
selecting
all the objects in a document, 98
anchor points, 92, 96
artboards, 10
brush strokes via a command, 93
clipping paths (masks), 93, 346
clipping sets, 345
via commands, 92–93
compound shapes, 336
deselecting objects, 98
direction handles, 93, 150
with Direct Selection, tool, 92
embedded images, 292
fill colors, 83
with Lasso tool, 96
layers, 176–177
line segments, 92, 96
Live Paint group faces/edges, 232
with Magic Wand tool, 97
masked objects, 93, 346
multiple layers, 177
objects, 75
objects in clipping sets, 345–346
objects via Layers panel, 93, 178–180
objects with same fill or stroke attributes, 92–93
paint and dialog values, 37
with Selection tool, 91
stray points, 93
sublayers, 176–177
thumbnails (Bridge), 60, 62
tools for, 89–90
tracing presets, 221
type and no object, 254
type and object, 253
type objects, 93, 248, 254
workspaces, 34
workspaces (Bridge), 58
Selection & Anchor Display preferences
Anchor Point and Handle Display options, 380
Highlight Anchors on Mouse Over option, 92, 149, 380
illustrated, 380
Objects Behind option, 91, 380
Object Selection by Path Only option, 91, 380
Selection options, 380
Snap to Point option, 101, 107, 380
selections
deselecting, 98
dragging and dropping from Photoshop to Illustrator, 296
inverting, 98
renaming, 98
saving, 98
Selection tool
defined, 40
in duplicating objects, 102, 103
in group selection, 180
in Live Paint group face and edge selection, 234
in moving objects and groups, 99
in one/multiple objects selection, 91
readout from anchor point, 77
temporary access, 92
uses, 89
using, 75
selection tools, 89–98
Direct Selection tool, 92
functions, 89–90
Lasso tool, 96
Magic Wand tool, 97
Selection tool, 91
Select menu
All command, 98, 101, 246
Deselect command, 98
Edit Selection command, 98
Inverse command, 98
Object submenu
All on Same Layers command, 93
Direction Handles command, 150
Text Objects command, 267
Same submenu, 92–93
Appearance command, 196
Blending Mode command, 353
Opacity command, 353
Save Selection command, 98

Separations Preview panel
in changing black knockouts, 403
defined, 52, 402
in identifying objects with rich or 100% K black, 403
illustrated, 52
Overprint Preview option, 402, 403
using, 391, 402–403
in viewing CMYK color plates, 402–403

shadows
Drop Shadow effect, 204
in knife drawing exercise, 286
for point type, 275
reflecting, 275
slanting, 275

Shape Builder tool, 327–331
defined, 40, 327
dividing objects with, 330
extracting objects with, 329
with In Merge Mode… option, 331
options, 328
splitting path segments with, 331
uniting objects with, 329, 330
using, 327–330
Shape Builder Tool Options dialog, 328

Shape Mode commands
applying, 331–333
defined, 331
guidelines for using, 331

Shape Options dialog, 201
shearing
with Free Transform tool, 138
with Shear tool, 140–141
with Transform panel, 142–143
Shear tool
defined, 41
options, 141
for slanting shadows, 275
using, 140–141

shortcuts
Bristle brush size and opacity, 311
closing files, 14
coloring, 116
entering values in panels, 38
hiding and showing panels, toolbar, 39
layer views, 185
paragraph alignment, 264
reshaping tools, 152
Save dialogs, 14
showing type panels, 51
symbolism tools, 363
Transform panel, 142
zooming, 27

Slices preferences, 385

Smart Guides
aligning objects with, 100–102
defined, 100
drawing paths with Pen tool and, 282
with Free Transform tool, 139
Measurement Labels option, 77, 139
Object Highlighting option, 92, 253
Transform Tools option, 101, 139
Smart Guides preferences, 384–385
Alignment Guides option, 100–101, 280, 285, 384
Anchor/Path Labels option, 100–101, 285, 384
Construction Guides option, 139, 384
Display Options options, 280, 281, 384
illustrated, 385
Measurement Labels option, 77, 139, 384
Object Highlighting option, 92, 253,
Transform Tools option, 101, 139
See also preferences

Smart Objects
Smart Objects (Photoshop), 424

Smart Punctuation dialog, 260
smooth points
converting, 150
converting corner points to, 284
converting to corner points, 283, 284
direction handles, 147
illustrated, 147
See also anchor points
Smooth tool
defined, 41
in smoothing edges, 160, 161

spacing type
kerning and tracking, 258–259
inset, 243
letter and, 259
paragraph, 265

Spiral tool
defined, 41
previous settings, 81
using, 82

spot colors
copying between files, 126
defined, 112
for effects, 204
in EPS files, 412, 413
gradient, converting, 397
from libraries, 118
proofing, 118
replacing, 132
on Separations Preview panel, 402
tint percentage of, changing, 119
See also process colors
Squeeze effect, 199, 200
Stamp effect, 208
Star tool
dialog, 79
illustrated, 41
using, 79–80

strikethrough type style, 255

stroke colors
gradients and, 332, 336
saving as swatches, 116
See also colors; fill and stroke colors

Stroke panel
Align buttons, 120
Arrowheads picker, 121
Cap buttons, 120–121, 122
Corner buttons, 121
Dashed Line option, 122
defined, 53
displaying, 120
illustrated, 53
Miter Limit value, 121
Profile menu, 156
Profile preset picker, 159
unit of measure, 382
Weight area, 120

strokes
adding appearance attributes to, 194
adding arrowheads/tails to, 121
adding to type characters, 277
alignment, changing, 120
applying brush strokes to, 298
applying gradients to, 322, 336
attributes, replacing, 132
blending mode, changing, 351
cap/corner style, changing, 120–121
changing width of, 156–159
cornering to filled objects, 336
dashed or dotted, 122
defined, 83
multiple attributes, applying, 193
opacity, changing, 351
overprint, 403
removing brush strokes from, 85
weight, 83, 120
stroke width
- adjusting with values, 157
- reshaping with Width tool, 157
- variable width profile preset, 156, 159

sublayers
- creating, 174
- defined, 174
- deleting, 175
- duplicating, 182
- merging, 187
- moving, 185
- releasing, 186
- selecting, 176–177
  See also layers

subscript characters, 261, 262
Suite Color Settings dialog, 20
superscript characters, 261, 262
SVG Compressed (svgz) file format, 13
SVG (svg) file format, 13
Swatch Conflict dialog, 126

swatches
- color groups, 125, 130, 131, 370, 372, 374, 376
- conflicts, resolving, 126
- copying between files, 126
- deleting, 127
- display, controlling, 124
- duplicating, 127
- editing in Edit Colors dialog, 375
- global process color, replacing, 132
- gradient, 318
- Kuler, 131, 375
- library, saving, 127
- locating, 124
- pattern, 135, 136
- restoring, 127
- saving colors as, 116
- types of, 124

Swatches panel
- adding colors from Color Guide panel to, 130
- adding colors from Kuler panel to, 131
- adding colors from Recolor Artwork dialog to, 370, 372, 374, 376
- Add Selected Colors option, 116
- Add Used Colors option, 116
- defined, 53
- Delete Swatch button, 127
- display options, 124
- illustrated, 53
- loading gradients onto, 318
- New Color Group button, 125
- New Swatch button, 116, 127
- Show Swatch Kinds menu, 124, 127
- Swatch Libraries menu, 118, 126, 127, 132, 221, 318
- temporary, applying colors, gradients, or patterns via, 114
- using, 116, 124–127, 132

Swatch Options dialog, 132
symbol instances
- adding to symbol sets, 358
- applying commands to, 357
- applying graphic styles to, 367
- bringing closer together/apart, 364
- creating, 357
- deleting from symbol sets, 358
- duplicating, 357
- expanding, 368
- registration point, 359, 361, 363
- renaming, 360
- replacing symbols in, 359
- rotating, 365
- scaling, 365
- screening, 366
- tinting, 366
- unlinking from symbol, 367

Symbolism Tools Options dialog, 362
symbol libraries
- accessing, 356–357
- illustrated, 356
- saving, 361

Symbol Options dialog, 360
symbols, 355–368
- advantages of, 355–356
- aligning to pixel grid, 359
- breaking link to instances, 367
- creating, 360
- creating instances of, 357
- creating sets of, 358
- defined, 355
- deleting, from Symbols panel, 360
- editing, 361
- importing, 357
- Live Paint groups from, 228
- redefining, 361
- renaming, 360
- replacing, 359
- saving libraries of, 361
- scaling, 252
- sorting, 357
- thumbnails, 357
  See also symbol instances; symbol sets

Symbol Screener tool
- functions, 364, 366
- illustrated, 41
- options, 362
- using, 363

Symbol Scruncher tool
- functions, 364
- illustrated, 41
- options, 362
- using, 363

symbol sets
- adding instances to, 358
- applying commands to, 357
- Control panel, 42
- creating with Symbol Sprayer tool, 358
- deleting instances from, 358
- expanding, 368
- replacing symbols in, 359

Symbol Shifter tool
- functions, 364
- illustrated, 41
- options, 362
- using, 363

Symbol Sizer tool
- functions, 365
- illustrated, 41
- options, 362
- using, 363

Symbols panel
- Break Link to Symbol button, 367
- defined, 53
- deleting symbols from, 360
- display, changing, 356
- illustrated, 53, 355
- New Symbol button, 360
- Place Symbol Instance button, 357
- Reference Point locator, 359
- Save Symbols button, 361
- Symbol Libraries menu, 252, 356

Symbol Spinner tool
- functions, 365
- illustrated, 41
- options, 362
- using, 363

Symbol Sprayer tool
- adding/deleting instances from sets with, 358
- choosing options for, 362
- creating symbol sets with, 358
- defined, 40

Symbol Stainer tool
- before using, 366
- expanding sets after using, 368
functions, 366
illustrated, 41
options, 362
using, 363
Symbol Styler tool
functions, 367
illustrated, 41
options, 362
use sequence, 367
using, 363
synchronizing color settings, 20

T
Tab key, 270
tabs
clearing, 271
inserting into text, 270
marker, moving, 271
modifying, 271
setting, 270–271
stops, creating sequence of, 271
Tabs panel
defined, 54
illustrated, 54
using, 271
targeting objects, 178, 190, 192, 198, 276, 353
tearoff toolbars
creating, 39
hiding and showing, 39
illustrated, 41
templates, document
creating, 5
opening, 4–5
previewing, 4
saving files as, 5
text
aligning with tab stops, 270
copying or moving characters, 246
importing, 247
inserting and deleting characters, 254
inserting tabs into, 270
threaded, 248–249
See also type
Text Import Options dialog, 247
textures, 208
Text Wrap Options dialog, 274
text wraps, 274
threaded text
creating, 248
releasing objects from, 249
revealing, 249
unthreading, 249
thumbnails (Bridge)
in collections, 69–70
controlling metadata display for, 65
cycling through, 61
displaying, 60
filtering display of, 72
labeling and rating, 71
removing ratings or labeling from, 71
resizing, 64
sorting order, 72
stacking, 67
Thumbnails preferences (Bridge), 65
TIFF files
as export format, 419
importing, 291
TIFF Import Options dialog, 291, 295
TIFF Options dialog, 419
tints
applying to symbol sets, 366
in brush strokes, 313
percentage, changing, 119
tools
accessing, 39
Add Anchor Point, 41, 151
Arc, 41
Area Type, 41, 239, 242
Artboard, 7, 8, 9, 10, 40
Blend, 40
Bloat, 41
Blob Brush, 40, 87–88, 160
Column Graph, 40
Convert Anchor Point, 41, 149, 150, 284
Crystallize, 41
Delete Anchor Point, 41, 154
Elliptical, 41, 76
Eraser, 40, 161
Eyedropper, 40, 123
Flare, 41
Free Transform, 40, 138–139
Gradient, 40, 320, 323, 324
Group Selection, 41, 90
Hand, 28, 40
Knife, 41
Lasso, 40, 90, 96
Line Segment, 40, 81
Live Paint Bucket, 41, 227, 228, 229–231
Live Paint Selection, 41, 232
Magic Wand, 40, 90, 97
Measure, 41
Mesh, 40
options, selecting, 39
Paintbrush, 40, 85, 153, 155, 228, 233, 238
Path Eraser, 41
Pen, 40, 153, 279–286
Pencil, 40, 84, 153, 155
Perspective, 40
pointers, 39
Polar Grid, 41
Polygon, 41, 78–79
Print Tiling, 41
Pucker, 41
Rectangle, 40, 76
Rectangular Grid, 41
Reflect, 41, 140–141
Reshape, 41, 162
for reshaping paths, 152
Rotate, 40, 140–141
Rounded Rectangle, 41, 77
Scale, 40, 140
Scallop, 41
Scissors, 41, 168
Selection, 40, 75, 89, 91
Shape Builder, 40, 327–331
Shear, 41, 140
Slice, 40
Slice Select, 41
Smooth, 41, 160, 161
Spiral, 41, 82
Star, 41, 79–80
Symbol Screener, 41, 362, 363, 366
Symbol Scruncher, 41, 362, 363, 364
Symbol Shifter, 41, 362, 363, 364
Symbol Sizer, 41, 362, 363, 365
Symbol Spinner, 41, 362, 363, 365
Symbol Sprayer, 40, 358, 362
Symbol Stainer, 41, 362, 363, 366
Symbol Styler, 41, 362, 363, 367
Twirl, 41
type, 40, 239, 240–242, 246
type on a path, 41, 239, 244, 251
Vertical Area Type, 41, 239, 242
Vertical Type, 41, 239, 241, 242, 246
Vertical Type on a Path, 41, 239, 244
Warp, 41
Width, 40, 157, 158, 159, 308
Wrinkle, 41
Zoom, 27, 40
Tools panel, 39–41
  Color controls, 40
  Default Fill and Stroke, 40, 114
defined, 39
drawing modes, 40, 75, 103, 176, 312, 343, 347
Fill color square, 40
hiding and showing, 39
illustrated, 40–41
screen modes, 29, 40
Stroke color square, 40
Swap Fill and Stroke button, 40
using, 39

TOYO Color Finder colors, 118

tracing
  choosing options before, 221
  converting to Live Paint groups, 226
  converting to paths, 225
  features, 219
  live, expanding/recoloring, 225–226
  options, 221–223
  presets, 220, 221, 224, 407
  raster images, 220
  releasing, 224
  results, customizing, 220

Tracing Options dialog, 221–223
  accessing, 220
  illustrated, 221
  using, 221–223

Tracing Presets dialog, 223, 224, 407

tracking type, 258

transformations, 137–146
  applying via dialogs, 141
  via bounding boxes, 137
  of brushes, 314
  of compound shapes, 336
  constrain angle for, 139, 378–379
  via Control panel, 143
  copy of objects, 141
  default angles for, 139, 378–379
  as editable effects, 143
  flip and scale simultaneous, 141
  with Free Transform tool, 138–139
  math, 143
preferences for, 139
  with Reflect tool, 140–141
  repeating, 146
  with Rotate tool, 140–141
  with Scale tool, 140–141
  with Shear tool, 140–141
  Smart Guides and, 139
  symbol instances, 359
via Transform Effect dialog, 145
via Transform panel, 142–143
type, 250
user-defined reference point, 140–141

Transform Each dialog, 144

Transform Effect dialog, 145

Transform panel
defined, 54
illustrated, 54
Scale Strokes and Effects option, 142
shortcuts, 142
temporary, 142
using, 142–143
W, H, X, Y fields, 143

transparency, 349–354
  custom flattener options, 405–406
  exporting, 351
  exporting to Photoshop, 424
  flattening control, 404–406
  GIF format and, 420, 422
  grid, 354
  InDesign and, 404
  JPEG format and, 420
  settings, applying 349–351
  settings, objects affected by, 352–353

Transparency Flattener Preset Options dialog, 407

Transparency panel
  accessing, 349
  Add New Effect menu, 191, 194
  Blending Mode menu, 350
defined, 54
illustrated, 54
  Isolate Blending, 352
  Knockout Group option, 353
  opacity and blending mode controls, 349–351
temporary, 191, 350–351

trapping, 403

trim marks
  printing, 394
  producing for objects and groups, 408

TRUMATCH process colors, 118

Twist effect, 197, 205
type
  applying appearance attributes to, 276–278
  applying color to, 240, 254
  applying effects to, 198, 276, 278
  applying gradients to, 320
  area, 242–243
  baseline shift, 272
  blending mode, changing, 351
case, changing, 262
on a circle, 251–252
creator, options, 263
copying, 246
creating, 240–245
  area, 242–243
  path, 244–245
  point, 240
  in rectangle, 241
deleting characters, 254
exercise, 251–252
exporting to Web, 420
Fit Headline command, 259
font/font family, 240, 255
font size, 256
Free Distort effect on, 278
glyphs, 261–262
horizontal, making vertical, 250
hyphenation, 263
kerning, 258
leading, 257
moving, 246
for online viewing, 259
opacity, changing, 351
outlines, 273
overflow, 248–249
path, 244–245
point, 240
quotation marks, 260
recoloring after creation, 240
rotating, 250
scaling, 256
selecting, 253–254
selecting all, via a command, 93
selecting for recoloring, 117
selecting with its object, 253
selecting without its object, 254
Smart Punctuation, 260
spacing of, changing, 259
special effects, 274–275, 277–278
strikethrough, 255
threading, 248–249
tracking, 258
transforming, 250
underline, 255
vertical, making horizontal, 250

Type menu
  Area Type Options dialog, 243
  Change Case submenu, 262
  Create Outlines command, 273, 339
  Fit Headline command, 259
Smart Punctuation command, 260
Threaded Text submenu, 248, 249
Type on a Path submenu, 245
Type Orientation submenu, 250
type objects
  copying, 246, 248
  creating, 240–242, 244
deselecting, 248
selecting, 93, 248, 254
selecting type and, 253
threading, 248–249
unthreading, 249
Type on a Path Options dialog, 245
Type on a Path tool
  in creating path type, 244
defined, 41
font and font size selection, 240
uses, 239
Vertical Area Type tool
  defined, 41
  in entering type in closed path, 242
  font and font size selection, 240
  uses, 239
Vertical Path Type tool
  in creating path type, 244
defined, 41
font and font size selection, 240
uses, 239
Vertical Type tool
  copying and moving type, 246
  creating point type, 240
  creating type in rectangles, 241
defined, 41
  entering type in closed path, 242
  font and font size selection, 240
  selecting quickly, 257
  uses, 239
View menu
  Actual Size command, 30
  Edit View command, 31
  Fit All in Window command, 10
  Fit Artboard in Window command, 6
Guides submenu
  Clear Guides command, 109
  Make Guides command, 108
  Show Guides command, 107
New View command, 31
Outline command, 30
Overprint Preview command, 403
Pixel Preview command, 30, 82, 110
Preview command, 30
Proof Colors command, 22
Proof Setup submenu, 22
Rulers > Show Rulers command, 107
Show Artboards command, 6
Show Bounding Box command, 103, 137
Show Gradient Annotator command, 320
Show Grid command, 110
Show Print Tiling command, 6
Show Text Threads command, 249
Smart Guides command, 77, 92, 100, 139, 253, 357, 384
Snap to Grid command, 110
Snap to Pixel command, 30
Snap to Point command, 107
views, document, 30–31
Warp Options dialog, 199, 200
Web
  colors for, 113
  compression, 420
  GIF format, 420, 422
  image size, 420
  JPEG format, 420, 423
  optimizing files for, 420–423
  saving for, 421–423
Width Point Edit dialog, 157
width points
  creating discontinuous, 158
  editing, 157, 159
  moving, 157
Width tool
  in creating width profile presets, 159
defined, 40
  reshaping strokes with, 157
  scaling Art brush strokes with, 308
Window menu, 32, 37, 97, 131, 271
Window menu (Bridge), 60, 64
Windows
  Application frame, 23
  exiting Illustrator in, 14
  Explorer, opening files from, 55
  launching Illustrator in, 2
Windows Metafile (wmf) format, 419
word spacing, 259
Word text format, 247
working space profiles, 16
Workspace menu, 34–36
workspaces, 34–36
  deleting, 36
  editing, 36
  saving, 35
  selecting, 34
workspaces (Bridge)
customizing, 64–66
  deleting user-saved, 66
  Essentials, 59, 66
  Filmstrip, 66
  Light Table, 59
  order on switcher, changing, 58
  panes and panels configuration, 64
  Preview, 59
  resetting, 66
  saving, 66
  selecting, 58
Zig Zag effect, 166
zoom levels, changing, 27
Zoom tool, 27, 40
underline style, 255
Unite command, 167, 330–333
uniting shapes, 329, 330–333
Units preferences, 382
User Interface preferences, 388
variable width profiles
  applying, 84–85, 156
  presets, creating, 159
  removing, 85, 156
  restoring default to picker, 159
Variation Options dialog, 128